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お問い合わせ先 

Audinate Pty Ltd 

Level 1, 458 Wattle Street 

Ultimo NSW 2007 

AUSTRALIA 

Tel: +61 2 8090 1000 

郵送先 

Audinate Pty Ltd 

PO Box 855 

Broadway NSW 2007 

AUSTRALIA 

Audinate Inc 

1732 NW Quimby Street  

Suite 215 

Portland, OR 97209 

USA 

Tel: +1 503 224 2998 

info@audinate.com 

www.audinate.com 

著作権 

© 2014 Audinate Pty Ltd. All Rights Reserved.不許複製 

Audinate®、Audinate ロゴ、Dante は Audinate Pty Ltd の商標です。 

他のすべての商標は、それぞれの所有者に帰属します。 

Audinate 製品は、1 件または複数件の米国特許 7747725、8005939、7978696、8171152、およびそ

の他の出願中または発行済みの特許に保護されています。詳細は www.audinate.com/patents をご覧

ください。 

  

mailto:info@audinate.com
http://www.audinate.com/
http://www.audinate.com/patents
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法的通知および免責事項 

Audinate は本書の知的所有権をすべて有します。 

本書に記述された内容は参考情報として提供するものです。情報の正確性と完全性について十分な注

意を払っていますが、誤りや欠落があった場合に Audinate はいかなる保証も責任も負うものではあ

りません。 

本書の情報を利用した結果として生じるいかなる損失あるいは損害に対しても Audinate は責任を負

いません。本書の情報は読者が自らの判断について責任を持つこと、また関連情報や内容のすべては

独自のアドバイザーに確認することを前提に提供されるものです。 

ソフトウェア使用許諾権について 

Audinate は、同社およびサードバーティーの使用許諾契約に基づく製品を販売流通します。 

各ライセンスについての詳細およびそのコピー取得については、弊社のウェブサイトをご覧ください。 

www.audinate.com/software-licensing-notice 

http://www.audinate.com/software-licensing-notice
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Audinate について 
Audinate は AV システムのメディアネットワーク製品を提供する代表的な企業です。Audinate のクラ

イアントはプロフェッショナルオーディオ／ビジュアル業界で活躍しており、その主要な製品におい

て Audinate の特許である Dante メディアネットワーク技術が採用されています。 

Dante は特にライブイベント、大規模商業施設、公共放送、レコーディングプロダクション、コミュ

ニケーションシステムなどで利用されています。 

Audinate は米国、英国およびオーストラリアに拠点を置いています。会社の情報や最新ニュースにつ

いては www.audinate.com を参照してください。 

Dante は「Digital Media Networking Perfected」と称されるように最適化されたデジタルメディア

ネットワークを提供します。 

Dante について 

Audinate の Dante 技術は、プロのライブサウンド、オーディオ／ビデオ設置、放送、レコーディング

システムで要求される音質や性能要件を満たした、高性能デジタルメディアネットワークを提供しま

す。 

Dante は現在および将来におけるネットワーク機器の機能をフル活用するように設計されており、従

来型のオーディオネットワーク設計の制約を受けないメディア伝送方式を採用しています。また、性

能面でも制約を受けない頑強かつ柔軟なオーディオネットワークを容易に構築できます。Dante はギ

ガビットおよび 100Mbps のネットワーク環境で、異なるサンプリング周波数と量子化ビット数の

オーディオを同時に伝送することができます。また、異なるレイテンシーを持つネットワークゾーン

の設計も可能です。 
Dante はイーサネットだけでなくインターネットプロトコルに基づいています。イーサネット上で標

準 IP を使用するため、市販の安価なコンピュータネットワークのハードウェアで動作することがで

き、標準 QoS を使用することによって、ネットワークが他のデータおよびコンピュータのトラ

フィックと共用可能になります。 

さらに、Dante はサンプル精度の同期が可能で、プロオーディオに求められる極小レベルのレイテン

シーでのオーディオ伝送を実現します。オーディオ伝送とは別の同期手法によって、複数のスイッチ

をまたぐ場合であっても、異なるチャンネル／機器／ネットワーク間での完全な同期再生ができます。 

また、機器の自動認識やシステム設定によってプラグ＆プレイを実現するネットワークを構築します。

Dante 対応機器では自動的にネットワーク構成が設定され、機器自体、およびそのチャンネルの情報

がネットワーク上に通知されるため、複雑で間違いやすい設定手順は避けることができます。また

ネットワーク機器とその入出力信号に覚えやすい名前を付けることもできます。 

Dante はオーディオチャンネルの設定と伝送だけでなく、機器特有のメッセージや各メーカーが規定、

開発した制御信号など、制御およびモニター情報を Dante IP ネットワーク上で送受信するメカニズム

も提供します。 

Dante は頑強な構成基盤を持ち、現在および今後も進展し続けるネットワーク規格とリンクしており、

他種のデジタルオーディオ伝送では不可能な、将来の技術への対応が可能です。ネットワーク技術の

革新を続けていくことは、Dante のロードマップに欠かせない要素です。 

Dante の技術は導入の簡単なハードウェア／ソフトウェア製品、リファレンス設計、および開発 API
で利用できます。  

詳細については  www.audinate.com を参照してください。 

http://www.audinate.com/
http://www.audinate.com/


Dante Controller ユーザーガイド 

  

10 
 

はじめに 

Dante Controller について 

Dante Controller は Dante ネットワークの設定とオーディオのルーティングを可能

にする Audinate 社のアプリケーションソフトウェアです。Windows および Mac 
OS X のシステムに対応しています。（詳細については後述の「システム最小要件」

を参照してください。） 

Dante Controller をインストールした Windows PC または Mac を Dante ネット

ワークに接続すると、以下の機能が使用できます。 

 ネットワーク上の Dante 対応オーディオ機器（以下、「機器」）とそのチャンネ

ルを表示 

 機器のクロックとネットワーク設定を表示 

 機器にオーディオをルーティングし、その状態を表示 

 オーディオチャンネルのラベルを数字から覚えやすい名前に変更 

 受信レイテンシーのカスタマイズ（再生タイミングのレイテンシー） 

 オーディオルーティングに関するプリセット情報の保存 

 以前に保存したプリセットの適用 

 プリセットをオフラインで編集し、新ネットワーク展開のための設定を適用 

 以下を含む機器設定オプションの表示と設定 

o 機器名の変更 

o サンプリング周波数とクロック設定の変更 

o 詳細ネットワーク情報の表示 

o 機器のウェブサイトにアクセスしてファームウェアとライセンス情報を更新（サポートされて

いる場合） 

o LED の点滅などによる機器の識別（サポートされている場合） 

 以下を含むネットワークステータス情報の表示 
o ネットワークを介したマルチキャスト帯域幅 

o 各機器の送受信帯域幅 
 レイテンシー統計とパケットエラーを含む機器性能情報の表示 

 周波数オフセット履歴とクロックイベントログを含む各機器のクロックステータス情報の表示 
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バージョン 3.5 の新機能 

 v3.5.6 
  Dante Controller は Ultimo 機器がアップグレードモードに入った場合、その機器をオレンジ色の文字

で表示します。 

  対応機器名を付ける際、数字を最初に付けることができるようになりました。 

  Mac OS X 10.10 が対応可能となりました。 

v3.5.1 
  Dante Controller は起動時にコンピュータにインストールされた Dante Control and Monitoring 

(conmon)サービスのバージョンをチェックします。もし conmon バージョンが Dante Controller の
バージョンと合わない場合は、Dante Controller を再インストールして conmon バージョンをアップ

デートするようメッセージが表示されます。 

 v3.5.0 
  プリセットが強化されました。これによりプリセットに保存されたパラメーターをフィルタリング

したり、プリセットファイルをオフライン編集したり（これにより Dante Controller をオフラインで

の設定ツールとして効果的に利用できます）、保存されたパラメーターセットをいかなるネット

ワーク上の互換性をもつ機器にも「機器のロール（役割）」として適用できます（サポートされて

いる場合）。詳細は Presets を参照してください。 

  対応機器では、新しい Device View > Latency タブで機器がサブスクリプションされている各トラン

スミッターのオーディオパケットレイテンシーのヒストグラムを表示できます。 

  対応機器では、"Clock Status Monitoring 機能"で機器のクロック安定性を示すヒストグラムを表示で

きます。 

  Dante Controller を、プライマリーおよびセカンダリーネットワークの両方に接続できるようになり

ました。万一プライマリーネットワークに障害が発生しても、リダンダントの回線側からシステム

のフルコントロールができます。 
  Channel Groups で機器チャンネルを 16 チャンネルごとのグループに分けることができます。 

  新採用のタブ、NetworkStatus でネットワーク上のすべての機器のネットワーク関連情報を表示でき

ます。 

Device View > Status タブにある“Clear Counters” ボタンを使うと、機器のパケットエラー履歴を消

去できます。 

  Device Status タブは Device Info となりました。 

  Clock Status タブが強化されました。 

  Events タブが強化されました。イベントが、重要度に応じてフィルターできるようになり、ステー

タスバーのイベントログアイコンが新しいイベントの通知を表示します。 

  新採用のタブ、Status Bar はプライマリーとセカンダリーネットワークの接続状態、マルチキャス

ト帯域幅（以前はツールバーに表示）、イベントログの通知アイコン、クロックステータスモニ

ターを表示します。 

  デザインと操作性が新しくなりました。 
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以前のバージョン 

v3.4.0 
 対応機器のメーターアイコンの表示を追加しました。 

 ネットワークのマルチキャスト帯域幅表示をメニューバーに追加しました。 

 イベントログアイコンが更新されました。 

 新規サブスクリプションを行うと、サブスクリプション進行中アイコンが表示されます。 
 クロック同期安定性のモニター機能でデバイスクロックが不安定かどうかの通知を表示します。 

 対応機器の Factory Reset を Clear Config に変更しました。 

 Mute Status を Device View > Status タブに追加しました。 

 Windows 用 Dante Controller では、機器の認識に、Apple Bonjour ではなく、Audinate の Dante 
Discovery サービスを使用します。Dante Discovery は Windows 用 Dante Controller v3.4.0 と一緒に

自動インストールされます。 

注:Dante Firmware Update Manager または Dante Virtual Soundcard をご使用の場合は Bonjour が必

要ですので、システムからアンインストールしないでください。 

v3.2.9 
 対応機器(Dante-MY16-AUD カード v3.3.9 以上)では Device View に HA Remote タブが含まれていま

す。 

 Mac 用 Dante Controller では OS X 10.8 をサポートします。 

v3.2.8 
 Switch Configuration（スイッチ設定） - 対応機器でカスタムスイッチ設定が可能です。 

 Device View > Status タブ - 対応機器で、Device View > Status タブの Device Information 欄に、該

当機器のメーカー、製品タイプ、製品バージョン情報が表示されます。機器の Dante 関連情報

（Dante モデル、Dante ソフトウェア、Dante ファームウェアのバージョン）は Dante Information
欄に表示されます。 

 Device Status View - Type および Version 欄の名称がそれぞれ Product Type、Product Version にな

りました。 

 様々な性能／安定性が強化されました。 
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システム最小要件 

以下の表はお使いのパソコンで Dante Controller を使用するために最低限必要なシステム仕様です。 

免責事項：コンピュータが以下の要件を満たしていても、特定のハードウェアに関する他の性能上の

問題が生じることがあります。その場合はお使いのコンピュータのシステム管理者に相談してくださ

い。 

全般 

 

構成品 推奨最小システム要件 

プロセッサー 1 GHz 以上 

メモリー 512 メガバイトの RAM 

ネットワーク 標準の有線イーサネットネットワークインターフェース（1Gbps/100Mbps） 
注:無線 LAN（Wi-Fi）には対応していません。  

 

Windows 

 

構成品 推奨最小システム要件 

OS Windows 7（SP1 以上）、または 8、8.1 
注:ホスト名および機器名以外は、UTF-8 と Unicode に対応しています。

DNS 規格はこれらに関して Unicode に対応していません。  

 

Mac OS X 

 

構成品 推奨最小システム要件 

OS Mac OS X 10.7.5、10.8.5、10.9.5 および 10.10 
注:Intel アーキテクチャにのみ対応しています。PowerPC には対応していま

せん。  

 

注:Dante Virtual Soundcard を Dante Controller と同じコンピュータにインストールする場合には、

Dante Virtual Soundcard についてのシステム最小要件も満たす必要があります。 

OS のアップデート 

PC または Mac が最新の OS にアップデートされていることを確認してください。 
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ファイアウォールの設定 

Windows ファイアウォールと Mac OS X 内蔵ファイアウォールの設定はインストール時に自動的に行

われます。 

Dante Controller は以下のポートで UDP 通信を行います。 

 Dante のコントロールとモニター: 8700-8705, 8800 

サードパーティーのファイアウォール製品を使う場合には、上記のポート情報を利用して設定してく

ださい。 

モニター要件 

 Dante Controller 用の推奨モニター解像度は 1024×768 以上、画面サイズは 19 インチ以上です。 
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Dante Controller のインストール 

Dante Controller のダウンロード 

Dante Controller は Audinate のウェブサイトからダウンロードできます。 

以下の手順でダウンロードします。 

1. Audinate のウェブサイトにアクセスします。www.audinate.com. 

2. Products > Dante Controller に進みます。 

3. 「Download」を行う際に、使用する OS を選択します。 

4. 赤色のダウンロードボタンをクリックします。 

この後、使用 OS に適合する Dante Controller リリースページに移ります。 

「File download」の中から Dante Controller インストーラーのリンクをクリックしダウンロードしま

す。 

Windows への Dante Controller のインストール 

Dante Controller の自動インストールファイルを適切なディレクトリ（例、C:\ downloads）にダウン

ロードした後、以下を実行します。 

インストール手順 

1. アドミニストレーターとしてコンピュータにログインしていることを確認します。 

2. Dante Controller のインストーラーファイルをダブルクリックします。 

3. 使用許諾契約書を読みます。内容に同意する場合は I agree（同意する）チェックボックスにチェッ

クを入れ、Install（インストール）をクリックします。同意しない場合は Close（閉じる）をクリッ

クします。 

4. Windows のセキュリティに関するメッセージが表示されたら確認します。 

Dante Controller がインストールされます。Dante Controller がスタートメニューの「Audinate」の下

に追加されます。 

Mac OS X への Dante Controller のインストール 

以下の手順で MacOSX に Dante Controller をインストールします。 

1. Dante Controller の.dmg ファイルをダブルクリックします。ドライブアイコンがデスクトップに表

示されます。これをダブルクリックして開きます。 

2. Dante Controller の.pkg ファイルをダブルクリックします。インストーラーが起動します。 

3. 使用許諾契約書を読み、内容に同意する場合は Agree（同意する）をクリックします。 

同意しない場合は Disagree（同意しない）をクリックしてインストールを中止します。 

http://www.audinate.com/
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Dante Controller のアンインストール 

新しいバージョンの Dante Controller をインストールする前に旧バージョンをアンインストールする

必要はありません。 

それでも旧バージョンをアンインストールしたい場合は以下の手順に従います。 

Windows 

コントロールパネル> Programs and Features＞Dante Controller を選択し、Uninstall（アンインス

トール）をクリックします。 

注:Dante Controller をアンインストールしても、Dante の２つの機能、「Dante Control and 
Monitoring」および「Dante Discovery」がプログラムリストに表示されている場合があります。これ

らの機能は他の Dante ソフトウェア（例：Dante Virtual Soundcard、Firmware Update Manager、お

よびサードパーティーの Dante コントロールアプリケーションなど）に必要なので、表示されていて

もアンインストールしないでください。不要になった場合は自動削除されます。 

Mac OS X 

アンインストールの際は.dmg ファイル内のアンインストールツールを使用してください。 
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Dante の基礎 

自動認識と自動設定 

Dante 対応機器を IP／イーサネットネットワークに接続すると、その機器は自動的に以下の動作を行

います。 

1. IP アドレスの設定 

2. 自動認識されるよう機器自体の情報を通知 

Dante 対応機器をネットワークに接続してから数秒以内に Dante Controller がその機器を自動認識し

て表示し、チャンネルの設定とオーディオのルーティングができるようになります。 

ネットワークの自動設定 

ネットワークに接続された Dante 対応機器は自動的に IP アドレスを含む自己のネットワーク設定を

行います。 

設備ネットワークでよくあるように、ネットワーク上に DHCP サーバーがある場合には、DHCP サー

バーは標準の DHCP プロトコルを使って Dante 対応機器に IP アドレスを設定します。 
仮設ネットワークや小規模ネットワークのように DHCP サーバーのないネットワークの場合には、

Dante 対応機器は PC やプリンタのように、リンクローカルプロトコルを使ってアドレスを自動割り

当てします。 

自動認識 

Dante 対応機器はその機器自体の以下の情報を他の Dante 機器および Dante Controller に通知します。 

 機器名 

 オーディオチャンネルのラベル情報 

 オーディオチャンネル数 

 サンプリング周波数と量子化ビット数 

この情報は Dante Controller で機器を表示させたときに確認できます。 オーディオをルーティングす

るためにサンプリング周波数が適合するかなど、Dante 機器と他の機器との互換性を判断するために

用いられます。 

機器のチャンネル 

Dante 機器には複数のチャンネルがあります。送信（Tx）チャンネルと受信（Rx）チャンネルの 2 種

類です。受信チャンネルと受信機器はグリッドの左側に表示されます。送信チャンネルと送信機器は

グリッドの上部に表示されます。 

送信チャンネルはネットワーク上で通知されます。受信機はこの通知を利用してチャンネルへのサブ

スクリプションを設定します。送信チャンネルはユニキャストまたはマルチキャストを使って複数の

受信機に送信することができます。 
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受信チャンネルはサブスクリプションによって送信チャンネルと接続されます。各受信チャンネルは

ネットワークを通して１つの送信チャンネルからのみオーディオを受信します。 

オーディオチャンネルのサブスクリプション 

Routing 画面で、Rx と Tx の交点の四角が青い場合は、これらのチャンネル間でオーディオ経路が作

成できるということです。四角がグレーの場合はチャンネル間の経路が作成できません。これは送信

機と受信機のサンプリング周波数が合っていないか、同一機器内部で送受信経路を設定できないため

です。 

送信チャンネルと受信チャンネルの交点にある青い四角をクリックするとサブスクリプションが作成

され、交点に緑色のチェックマーク が表示されます。サブスクリプションが進行中であることを

示すグレーの砂時計のアイコン が、最初一時的に表示されることがあります。 

サブスクリプションに問題があれば警告 またはエラー のアイコンが表示されます。同時にサ

ブスクリプションされている機器数が多いと、一時保留の黄色いアイコン が表示される場合もあ

ります。サブスクリプションのアイコンをマウスオーバーすると関連のツールチップが表示されます。

（サブスクリプションツールチップ を参照) 

注:サブスクリプションは Device View で作成することもできます。これについては Device View セク

ションで説明します。（Device View は Device Status 画面とは異なります。） 

複数オーディオチャンネルの一括サブスクリプション 
複数のオーディオチャンネルを一括でサブスクリプション設定するには、Ctrl キーを押しながら、二

つの機器の交点にある[－]をクリックします。送受信可能な全てのチャンネルが一括でサブスクリプ

ションされます（Routing 画面の拡張表示の図を参照してください）。 

オーディオチャンネルのサブスクリプション解除 
オーディオチャンネルのサブスクリプションを解除するには、サブスクリプションされているグリッ

ドの交点をクリックします。サブスクリプションのアイコンが削除され、元の青色の四角に戻ります。 

サブスクリプションステータス 
Routing 画面の Tx チャンネルと Rx チャンネルの交点に表示された記号は、以下に示すようにサブス

クリプションまたは接続の状態を示します。 

 進行中 サブスクリプションが進行中です。 

 サブスクリプション済 接続が確立され機能しています。 

 警告 サブスクリプションが不完全です。送信機がネットワークから外

されていたり電源が切れているなどでネットワーク上で認識され

ていない状態です。 

 エラー エラー発生 – たとえばサブスクリプションを確立するための帯域

幅が不足しているなど。 

 保留中 サブスクリプションの設定中です。多数の機器を同時にサブスク

リプション設定する場合によく見られます。 

注：サブスクリプションステータスは、ネットワークや他の機器の変更により、最初に確立した後で

も変化することがあります。 
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サブスクリプションツールチップ 

Routing タブのサブスクリプションアイコンをマウスオーバーすると、サブスクリプションに関する

情報のツールチップが表示されます。 

サブスクリプションに問題がなければ、ツールチップは Rx チャンネルと機器名、続けて Tx チャンネ

ルと機器名を表示します。（例：kick@Monitor-Console<- 01@Stagebox-2） 

 
サブスクリプションが上記以外の状態にある場合は別のメッセージが表示されます。 

よくあるメッセージとして下記の例があります。 

 不正なチャンネルフォーマット： ソースと伝送先が不一致 

受信機と送信機が異なるサンプリング周波数に設定されています。 

 クロックドメインの不一致： 受信機と送信機が同一のクロックドメインに属していません。 

1 台の機器が他の機器と異なるサンプリング周波数のプルアップ／プルダウン値に設定されています。 

 送信（Tx）スケジューラーの問題: 通常 100Mbps 以上のネットワークリンクでミリ秒以下のレイテ

ンシーの使用を試みた場合に発生します。（100Mbps を超えるリンクでは 1 ミリ秒がレイテンシー

の最小単位になります） 

 No Receive flows（受信フローなし）: 受信機はこれ以上フローをサポートできません。 

受信機がサブスクリプションしている機器の数が多すぎる場合に見られます。（通常機器はチャン

ネルと同数のフローをサポートしていません。）詳しくは「オーディオのルーティング」の「フ

ロー」を参照してください。 

 No more flows（フローなし）: 送信機はこれ以上フローをサポートできません。 

送信機がサブスクリプションしている機器の数が多すぎる場合に見られます。詳しくは「ファンア

ウト」を参照してください。 

入力チャンネルと出力チャンネルの見分け 

チャンネルは、オーディオデータをネットワークに送り出すか、ネットワークから取り込むかによっ

て分類されます。 

 ネットワークにオーディオデータを送り出すチャンネルを送信（Tx）または出力チャンネルと呼び

ます。 

 ネットワークからデータを取り込むチャンネルを受信（Rx）または入力チャンネルと呼びます。 
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機器名とチャンネルのラベル 

Dante では機器とオーディオチャンネルを番号ではなく名前とラベルで識別します。機器名とチャン

ネルラベルはカスタマイズできます。 

 Dante のルーティングは機器名とチャンネルのラベルを使います。受信チャンネルは、機器の送信

チャンネル名に対して受信のサブスクリプションを設定できます。 

例:“Analog L@my-transmitter”は、 “my-transmitter”という名前の機器の“Analog L”というラベ

ルのチャンネルを示します。Dante ネットワーク上の各機器は固有の名前であることが必要で

す。またチャンネルの各ラベルもその機器上で重複する名前は持てません。 

 機器名またはチャンネルラベルが変更された場合には、Dante のルーティングはそれを新しい別の

機器またはチャンネルであるとみなします。新しい機器またはチャンネルに古い名前が割り当てら

れると、Dante のルーティングは古い機器の代わりにこの新しい機器から行われます。 

例: 機器“stage-box”の電源部が故障し、“stage-box”を交換する必要が生じました。この古い

“stage-box”を取り外し、新しい機器を接続して“stage-box”のラベルを付けました。古い

“stage-box”からチャンネルを受信していた Dante 機器は、この新しい“stage-box”から受信す

るよう自動的に切り替わります。 

 ネットワーク上の機器には必ず固有の名前をつけてください。Dante Controller で、機器名としてす

でに同じネットワーク内で使用されている名前に変更しようとすると、メッセージが表示され名前

は変更されません。 

例: ネットワーク上に“MY16-slot1”と呼ばれる機器が存在します。ユーザーが別の機器の名前

を“MY16-slot1”に変更しようとすると、その名前は使用済みであるというメッセージが表示さ

れます。このため、その機器の名前は変更されません。 

 一方、すでにネットワーク内に存在する名前の付いた別の機器をネットワークに追加すると、名前

の重複が検出され、片方の機器名の最後に(2)が付きます。この機器は名前が正しく変更されるまで

オーディオ送信を行えません。 

注： 名前の末尾に(2)が付いた機器（例：  MY16-slot1(2)）は名前の変更処理が終わるまでオーディオ

を送信できないのでご注意ください。この機器の機能を完全に回復させるには、ユーザーが機器名を

重複しない有効な名前に変更する必要があります。 

名前とラベルの規則 

 全ての Dante 機器名とラベルは最大 31 文字です。いずれも大文字と小文字は区別されないため、た

とえば “Guitar”と“guitar”は同じラベルとして扱われます。また Unicode と非アルファベット文字に

は対応していません。 

 機器名は Domain Name System（DNS）のホストネーム規則に準ずる必要があります。有効な文字

は A～Z、a～z、0～9、および “-”（ハイフン）です。 

 Tx チャンネルのラベルは “=”（イコール）、“.”（ピリオド）、または “@”（アットマーク）以外の任

意の文字を使用することができます。Tx チャンネルのラベル名は１つの機器内で常に参照重複する

ことはできません。Tx チャンネルのラベルはネットワーク内では重複しても問題ありません。 Tx
チャンネルのラベルは機器名を常に参照するためです（channel@device）。 

 Rx チャンネルのラベルについては Tx チャンネルのラベルと同様です。 
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オーディオのルーティング 

ルーティングに関する用語 

 機器（デバイス）:「機器」とは Dante 対応機器のことで、特に、Dante 対応インターフェースを導

入したオーディオ機器のコンポーネントを指します。Dante 機器は通常、送信チャンネルと受信

チャンネル、およびその他のルーティング関連機能を持っています。 

 送信（Tx）チャンネル: 送信チャンネルは Dante 機器からネットワークにオーディオを送り出します。 

 受信（Rx）チャンネル: 受信チャンネルはネットワークからオーディオを受け取り、Dante 機器に送

ります。 

 フロー:  Dante のオーディオルーティングにより、フロー（経路）が作られます。それぞれのフロー

は１つの送信機から１つまたは複数の受信機へ複数チャンネルのオーディオを伝送します。ユニ

キャストルーティングは１つの受信機へのフローを作ります。マルチキャストルーティングは複数

の受信機により受信可能なフローを作ります。マルチキャストフローには ID が割り当てられ、

Dante Controller で識別できるようになっています。 

 ユニキャストルーティング:  ユニキャストフローは１つの送信機から１つの受信機への１対１の伝送

です。１つのユニキャストフローには、通常 4 チャンネル分のオーディオデータが含まれます。 

 マルチキャストルーティング: マルチキャストフローは１つの送信機から任意の数の受信機への１対

多の伝送です。Dante Controller を使って、どのチャンネルをマルチキャストにするかを選択するこ

とができます。ユニキャストルーティングとは異なり、マルチキャストルーティングでは受信機が

ない場合であってもネットワーク帯域幅を消費しますが、受信機が増えても帯域幅を追加する必要

はありません。 
 サブスクリプション: サブスクリプションは、受信チャンネルで、別の Dante 機器の送信チャンネル

からのオーディオを受信するように設定します。 

 サブスクリプションステータス受信チャンネルに関して、サブスクリプションを行っているか、ユ

ニキャストまたはマルチキャストオーディオを受信しているか、サブスクリプションが良好か、エ

ラーが生じているかを示します。 

サブスクリプション 

Dante のルーティングを行うには受信（Rx）チャンネルを送信（Tx）チャンネルにリンクさせます。

これをサブスクリプションと呼んでいます。 

例:“Source”というラベルの機器の Tx チャンネル 1 および 2（“Audio L”と“Audio R”のラベルが

付けられている）を“Dest”というラベルの機器の Rx チャンネル 3 および 4 にルーティングし

ます。 

 

“Dest”機器上の Rx チャンネル 3 と 4 が以下のようにサブスクリプションされます。 

 3. Audio L@Source 

 4. Audio R@Source 

Dante は Tx チャンネルから Rx チャンネルにオーディオを伝送するために必要なオーディオルーティ

ングを行います。 

ネットワーク 
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リダンダンシー 

Dante 機器の多くはリダンダンシーを持つオーディオルーティングに対応しています。これらの機器

はプライマリーとセカンダリーのラベルを持つ２つのネットワークインターフェースを備えています。

プライマリーインターフェースは１つの物理ネットワークに接続する必要があります。リダンダン

シーを用いる場合には、セカンダリーインターフェースを別のネットワークに接続する必要がありま

す。セカンダリーインターフェースはプライマリーインターフェースと通信することはできません。 

 
 

 

機器でセカンダリーネットワークが利用可能な場合には、リダンダンシーが自動的に有効になります。

同じオーディオデータがプライマリーとセカンダリー両方のネットワークに同時に送信されます。片

方のネットワークに問題が生じた場合でも、もう片方のネットワークを通して引き続きそのオーディ

オデータをフローします。 

注: Dante のリダンダンシーでは、任意のリダンダンシー対応機器のプライマリーおよびセカンダ

リーの両インターフェースが同じリンクスピードで接続していることが必要です。たとえばプライマ

リーインターフェースが 1 Gbps のスイッチポートに接続されている場合、セカンダリーインター

フェースも 1 Gbps のスイッチポートに接続しなければなりません。同様に、プライマリーインター

フェースが 100 Ｍbps のスイッチポートに接続されている場合、セカンダリーインターフェースも

100 Ｍbps のスイッチポートに接続しなければなりません。 

注: リダンダンシー非対応の Dante 機器はプライマリーネットワークにのみ接続してください。  

オーディオフォーマット 

ほとんどの Dante 機器は幅広いオーディオフォーマット（サンプリング周波数）をサポートしていま

す。機器は通常オーディオフォーマットでの切り替えが可能ですが、一度にサポートするフォーマッ

トは 1 つのみです。 

オーディオフォーマットが同じチャンネルの間でのみサブスクリプションを設定することが可能です。

互換性のないフォーマットの機器のチャンネルの色はグレー表示となり、ルーティングできません。 

（プライマリー

ネットワークに

要接続） ネットワーク A
（プライマリー） 

リダンダンシー非

対応の Dante 機器 

ネットワーク B
（セカンダリー） 

リダンダンシー対応の

Dante 機器 

リダンダンシー対

応の Dante 機器 
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フロー 

Dante のオーディオルーティングにより、フローが作られます。1 つのフローで、１つの送信機から

１つまたは複数の受信機に 1 系統または複数のチャンネルが送られます。フローにはユニキャストと

マルチキャストの２種類があります。 

ユニキャストルーティングで１つの受信機へのフローが作られます。通常、ユニキャストフローには

最大４チャンネルのオーディオが含まれます。ユニキャストフローは受信機が利用可能なオーディオ

チャンネルをサブスクリプションしたときに設定され、受信機がそのフローのすべてのチャンネルの

サブスクリプションを解除したときに自動的に解除されます。 

マルチキャストルーティングは複数の受信機により受信可能なフローを作ります。マルチキャストフ

ローには ID が割り当てられ、Dante Controller で識別でき削除も簡単にできます。ユニキャストフ

ローとは異なり、マルチキャストフローは、送信側の機器でまず設定しないと、受信機でこのフロー

へのサブスクリプション設定をすることができません。 

高度なルーティング: マルチキャストを用いた高度なルーティング 

デフォルトの Dante のルーティングはユニキャストです。つまり、各送信機と受信機間で個別のフ

ローが設定されます。1 台の送信機から同一チャンネルを複数受信機で受信したい場合には、マルチ

キャストを使ってより効率化できる場合があります。 

マルチキャストでは複数の受信機に同じ複数チャンネルが送られます。これは実際、かなりの量の

オーディオフローがネットワークの隅々まで流れることになります。多数の受信機で同じ複数チャン

ネルを受信したい場合、マルチキャストなら特に送信機側でネットワーク全体の消費量を削減するこ

とができます。各オーディオチャンネルにつき複数でなく 1 つのみコピーを送信すれば良いからです。 

Dante の受信機でマルチキャストが利用可能な場合には、自動的にユニキャストより優先して使用さ

れます。すなわち、受信機が現在ユニキャストとして受信しているチャンネルを含む新しいマルチ

キャストのフローが生成された場合には、受信機はマルチキャストフローからのオーディオの受信に

切り替わり、ユニキャストフローは削除されます。 

Clock Synchronization（クロック同期） 

Dante 対応機器はネットワーク全体で IEEE 1588 Precision Time プロトコル（PTP）を使用して、

ローカルクロックをマスタークロックに同期し、これによりネットワーク全体でサンプル精度の同期

を行います。 

１つの Dante 機器がネットワークの PTP マスタークロックに選定され、他のすべての Dante 機器は

マスタークロックに対する PTP スレーブクロックとなります。Dante 機器の多くは PTP マスターク

ロックとなる機能を持っていますが、1 台のみがマスターとなります。クロック入力（ワードクロッ

クまたは AES3 など）を持つ機器は優先的にマスタークロックに選ばれます。同様にギガビットに接

続された機器は 100 Mbps に接続された機器よりも優先的にマスタークロックに選ばれます。複数の

同等の機器がマスタークロックの候補となった場合には、MAC アドレスが最小の機器が選定されま

す。機器に手動で「Preferred（優先）マスター」と設定した場合には上記の選定プロセスより優先さ

れます。 

Dante ex Clock Types （クロックの種類） 

それぞれの Dante 機器は高品質の内蔵クロック回路からクロックを駆動することも、外部に接続され

たワードクロックからクロックを駆動することもできます。Dante Virtual Soundcard の場合には、コ

ンピュータのクロックが使用されます。 
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クロック設定 

Enable Sync To External（外部クロックとの同期） 
“Enable Sync To External（外部クロックとの同期）”に設定された Dante 機器はホスト機器からの

ワードクロックに同期します。そしてこの項目にチェックされた Dante 機器は、“Preferred Master”に
セットされた Dante 機器が他にない限り、PTP マスタークロック（ネットワーク上のクロックマス

ター）となります。 

Preferred Master（優先マスター） 
特定機器が PTP マスタークロックを供給する設定が必要な場合もあります。“Preferred Master”に設

定された Dante 機器は常に PTP マスタークロックとして選定されます。２つ以上の機器で“Preferred 
Master”が設定されている場合には、MAC アドレスが最小の機器が選定されます。 

注:機器 A は外部ワードクロックソース（「外部クロックとの同期」参照）で駆動しているが、機器 B
が Preffered Master （優先マスター）として設定されている場合、機器 A は Dante ネットワークとの

同期が外れ、最終的にミュートされます。ただし機器 B が機器 A と同じ外部ソースからクロックを取

得している場合を除きます。 
クロックのステータス 

リダンダンシーネットワークでのクロックと同期 

リダンダンシーネットワークでは、クロック同期プロトコルはプライマリーとセカンダリーの両方の

ネットワークで動作します。各ネットワークには指定された PTP マスタークロックがあります。 通
常、これは両方のネットワークで同じ機器です。そうでない場合（たとえば、リダンダンシーを持た

ない機器が Preferred Master に指定されている場合）には、１つの機器がクロック同期情報をプライ

マリーネットワークからセカンダリーネットワークにブリッジして、すべての機器が同じクロック

ソースからクロックを受け取るようにします。リダンダンシーを持つ PTP スレーブクロックは、接

続されているどちらかのネットワークからの情報に基づいてローカルクロックを同期します。１つの

ネットワークに問題が生じた場合には、リダンダンシーを持つ機器はもう一方のネットワークからク

ロック同期情報の受信を継続します。 

Latency（レイテンシー） 

Dante では、ネットワークのレイテンシーの変動は受信機側で調整されます。各受信機には機器のレ

イテンシー設定があります。この設定により、入力オーディオサンプルのタイムスタンプとこれらの

サンプルが再生されるまでの間のレイテンシーが定義されます。 

通常、Dante 機器のデフォルトのレイテンシーは 1 msec です。これはギガビットネットワークコア

（スイッチ間で最大 10 ホップ）と Dante 機器への 100 メガビットのリンクから構成される大規模

ネットワークでは十分な値です。小規模のギガビットのみのネットワークでは小さいレイテンシーを

使うことができます。（PCIe カードなど速い機器で最小 150 µsec まで）推奨レイテンシーの設定は

Dante Controller に表示されます。 また、製品の取扱説明書にも掲載されている場合もあります。 

レイテンシーは受信機に設定されています。しかし、サブスクリプションが確立すると受信機と送信

機間に自動的にネゴシエーションプロセスが生じ、パケットロスを回避するための十分なサブスクリ

プションのレイテンシーを確保します。  

たとえば、Ultimo 機器は最小 2ms のレイテンシーをサポートしています。レイテンシーを 1ms に設

定した PCIe カード等のより速い機器が、Ultimo 送信機にサブスクリプションされると、レイテン

シーはサブスクリプションでサポートされる最低値の 2ms になります。その他の機器（Brooklyn II 機
器など）へのサブスクリプションは 1ms に設定されます。（あるいはその受信機に設定されたレイテ
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ンシー）このように、送信機がサポートしていなくても、機器のレイテンシーは確実に「デフォルト」

のレイテンシーに設定されます。 

注: 100 Mbps のネットワークポートに接続された機器の最小可能レイテンシーは 1 msec です。 
 
100 Mbps を超えるリンクで 1 msec 以下のレイテンシーを使用すると、サブスクリプションエラーに

なり、“Tx Scheduler Failure（送信スケジューラーの問題）”のツールチップが表示されます。 

レイテンシーモニター 

Dante Controller はサポートする機器にレイテンシーのモニターをします。詳細は Latency タブを参

照してください。 

レイテンシーと Dante Virtual Soundcard 

Dante Virtual Soundcard により、Apple Mac または Windows PC を Dante 機器として作動できます。

Dante Virtual Soundcard は、特殊なハードウェアを持たない汎用コンピュータで動作するため、DVS
送信機から受信される接続にはレイテンシーを追加する必要があります。 

Dante Virtual Soundcard には、動作の信頼性を高くするために、カスタムのレイテンシー値を設定し

ています。DVS 送信機からのチャンネルを受信している Dante 機器は、これらのチャンネルについ

てのみ自動的にこの大きいレイテンシー値を使用します。その他の Dante 機器から受信しているチャ

ンネルのレイテンシーには影響ありません。 

Dante のコントロールとモニター 

自動設定、自動認識、およびオーディオの伝送／ルーティングに加えて、Dante 対応機器は各種の方

法でコントロールとモニターができます。これにはクロック設定などの特定パラメーターの表示と変

更も含まれます。Dante 機器は Dante Controller で表示可能なステータスイベントを送ることもでき

ます。ステータスイベントにはクロックステータスの変化やネットワークインターフェースの変更が

含まれます。  

注: コントロールとモニターを管理するコンピュータのサービスは“ConMon”または“Dante Control 
and Monitoring”と呼びます。 
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Dante Controller の起動 

Dante Controller アプリケーションのインストール先 

Windows 

デフォルトでは、Dante Controller は以下のフォルダにインストールされます。 

C:\ Program Files\ Audinate\ Dante Controller\  

下記のどの方法でも起動することができます。 

 スタートメニューからスタート>プログラム>Audinate>Dante Controller>Dante Controller 

 スタート > 実行 からダイアログボックスに C:\ Program Files\ Audinate\ Dante 
Controller\ DanteController.exe を入力します。 

 インストールされたディレクトリ内の Dante Controller アイコンをダブルクリックします。  

Mac OS X 

Dante Controller アプリケーションはアプリケーションフォルダにインストールされます。 

以下の操作で起動します。 

 アプリケーションフォルダ内の Dante Controller アイコンをダブルクリックします。  

または： 

 アイコンをドックにドラッグして、そのアイコンをクリックします。 

Dante Controller の設定 

ネットワークインターフェースの選択 

Dante Controller は他の Dante 機器とプライマリーネットワーク、セカンダリーネットワークまたは

その両方で通信できます。このため、ホストコンピュータのどのインターフェースが Dante のどの

ネットワークに接続されているかを、Dante Controller で認識していることが必要です。 

Dante Controller を初めて起動すると、プライマリーおよびセカンダリーDante インターフェースを

選択するリストを表示した Configure Dante Interfaces（Dante インターフェースの設定）ダイアログ

ボックスが表示されます（下記参照）。インターフェースを選択すると、それが今後の使用のために

記憶され、次回 Dante Controller を起動したときにはこのダイアログボックスは表示されません。 
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このダイアログボックスを次回以降表示するには、メインツールバーの ボタンをクリックしま

す。  

ネットワークインターフェース設定ガイド 

プライマリーのみの Dante ネットワーク（非リダンダンシー） 
プライマリーネットワークのみを保有している場合は、1 つのインターフェースのみを Dante ネット

ワークに接続できます。 

例: 
下記の例では、Dante Controller で動作しているラップトップコンピュータと 2 台の Dante 機器がそ

れぞれのプライマリーインターフェースでスイッチに接続されています。これが標準的な非リダンダ

ンシーのネットワークです。 

ラップトップコンピュータがネットワークインターフェースを 2 つ保有している場合は、どちらも使

用可能です。 
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リダンダンシー設定でプライマリーとセカンダリーの 2 つのネットワークがあり、

ホストコンピュータのネットワークインターフェースは 1 つの場合 
プライマリーとセカンダリーのリダンダンシーネットワークを保有していて、ネットワークインター

フェースが 1 つだけの場合、コンピュータのネットワークインターフェースはプライマリーインター

フェースに設定する必要があります。そうすることで、すべての非リダンダンシー対応機器のコント

ロールができ、非リダンダンシー対応機器に接続するすべてのリダンダンシー対応機器の接続情報を

確認することができます。 

問題が発生して、プライマリーネットワークの接続が失われた場合でも、代わりにセカンダリーネッ

トワークに接続して機器のコントロールを維持できます。この場合、コンピュータをセカンダリー

ネットワークに接続しなおすなどの物理的な接続の変更と Configure Dante Interfaces のダイアログ

ボックスでインターフェースの選択を変更することが必要となります。 

例: 
下記の例では、Dante Controller で動作しているラップトップコンピュータが、プライマリーイン

ターフェースに設定されている 1 つのインターフェースのみを経由してスイッチに接続されています。 

2 台の Dante 機器は、プライマリースイッチにはそれぞれプライマリーインターフェース経由で、セ

カンダリースイッチにはそれぞれセカンダリーインターフェース経由で接続されています。2 つのス

イッチ間に接続はありません。これが、ネットワークインターフェースを 1 つだけ保有するコン

ピュータの標準的なリダンダンシーネットワーク設定と考えます。 

 

注: セカンダリーネットワークに接続されている場合、プライマリーネットワークのみに接続されて

いる機器はコントロールできません。（非リダンダンシー対応機器または Dante Virtual Soundcard）
機器名の確認は、ネットワークビューとサブスクリプションダイアログ（例：the Device View > 
Receive and Transmit タブ）でできますが、機器の設定の確認や変更はできません。またマスターク

ロックがプライマリーネットワークのみに接続されている場合、その名前はメイン画面のツールバー

の“Master Clocks（マスタークロック）”セクションではなく、MAC アドレスの文字列として表示さ

れます。 
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プライマリーとセカンダリーの 2 つのリダンダンシー設定ネットワークがあり、ホ

ストコンピュータのネットワークインターフェースも 2 つある場合 
プライマリーとセカンダリーのネットワークを保有していて、ホストコンピュータにネットワークイ

ンターフェースが 2 つある場合、それぞれのインターフェースをそれぞれのネットワークに接続しま

す。この場合プライマリーネットワークが使用不能になっても、すべてのリダンダンシー対応機器を

常時フルコントロールできます。  

例: 
下記の例では、Dante Controller で動作しているラップトップコンピュータと 2 台の Dante 機器がプ

ライマリースイッチはプライマリーインターフェース経由で、セカンダリースイッチはセカンダリー

インターフェース経由で接続されています。2 つのスイッチ間に接続はありません。これがネット

ワークインターフェースを 2 つまたはそれ以上保有するコンピュータの標準的なリダンダンシーネッ

トワーク設定です。 

 

注: Dante Controller を使用するには、標準の有線イーサネットネットワークに接続していることが必

要です。Configure Dante Interfaces（Dante インターフェースの設定）ダイアログボックスでは無線

LAN（Wi-Fi）および他の非標準有線イーサネットのインターフェースは表示されません。 

注: 同一のコンピュータに入っているすべての Dante アプリケーションは、プライマリーDante イン

ターフェースがどれであるかという認識を共有しています。たとえば、Dante Controller と Dante 
Virtual Soundcard を 1 台の PC にインストールし、Dante Virtual Soundcard から新しくプライマリー

インターフェースを選択した場合、Dante Controller の設定も新しく選択されたインターフェースに

自動的に切り替わります。 
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Dante Controller の使用方法 
Dante Controller には Network View と Device View の２種類のウインドウがあります。 

重要事項: Dante ネットワークルーティング（例: サブスクリプション、機器名、チャンネルラベルな

ど）を変更した場合は、少なくとも 5 秒間待ってから、その機器の取り外しや電源オフを行ってくだ

さい。そうすることで、変更内容が対象機器に必ず正しく保存されます。機器の設定内容（例: サン

プリング周波数、レイテンシー、クロック設定）はすぐに保存されます。 

注: Mac OS X ユーザー：以下のキーの組合せは Windows 用です。Mac コンピュータで Dante 
Controller をお使いの場合は、以下の手順において“Control”キーの代わりに“Command (コマンド)”
キーまたは“Apple”キーを、また該当する場合は標準の Mac のキーの組合せを使用してください。 

Network View 

Dante Controller は起動時、Network View の Routing タブが選択された状態で表示されます。 
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メニューバー 

Network View のメニューバーには４つのメニューがあります。File, Device, View および Help です。 

File 
 Load Preset  (Ctrl+L): ファイルから設定を読み込みます。 

 Save Preset  (Ctrl+S): 現在表示されている機器設定をファイルに保存します。 

 Exit (Alt+F4): Dante Controller を終了します。 

詳細は Presets を参照してください。 

ツールバー 

メニューバー 

タブ 

 

ステータスバー 
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Device 
 Refresh (F5): 表示されているネットワーク／機器データを更新します。 

 Device View (Ctrl+D): 新しい Device View ウインドウを開きます。 

View 
Channel groups（チャンネルグループ） をオンにします。 

Help 
 About:Dante Controller のバージョンと現在のイベントログファイルの場所を表示します。 

 License: 使用許諾契約のテキストを表示します。 

 Contents (Shift+F1): ヘルプウインドウを開き、ヘルプ項目を表示します。 

Tool bar（ツールバー） 

メニューバーの下に以下の 6 つのボタンを含むツールバーがあります。 

 

 

Reload Device Information 
（機器情報の再読み込み） 

ネットワークから最新の機器情報を検出して現在の表示を更新しま

す。新しい機器がネットワークに追加されたなど、ネットワークへ

の最新の変更が自動的に Dante Controller に反映されていないとき

に便利です。 

 
Load Preset（プリセット

の読み込み） 
すでに保存されているオーディオルーティング設定を読み込みま

す。詳細はプリセットを参照してください。 

 
Save Preset（プリセット

の保存） 
現在のオーディオルーティング設定を保存します。詳細はプリセッ

トを参照してください。 

 

Choose a Dante Interface
（Dante インターフェース

の選択） 

Configure Dante Interfaces（Dante インターフェースの設定）ダイ

アログを開きます。詳細は Dante Controller の設定を参照してくだ

さい。 

 
Clock Status 画面 クロックステータスのモニター機能をオンにします。詳細はクロッ

クステータスモニターを参照してください。 

 
Channel Groups（チャン

ネルグループ）: 
Channel Groups（チャンネルグループ）をオンにします。詳細は

Channel Groups（チャンネルグループ）を参照してください。 

 

ツールバーの右側には現在のマスタークロックが表示されます。 

Tabs（タブ） 

ツールバーの下にある下記のタブをクリックします。 

 Routing（ルーティング） 

 Device Info（機器情報） 

 Clock Status（クロックのステータス） 

 Network Status（ネットワークのステータス） 

 Events （イベント）: 
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タブの使い方は次のセクションで説明します。 

Status Bar（ステータスバー） 

Status Bar (ステータスバー)はネットワークのステータス、機器の通常イベント、クロックステータ

スのイベントの通知、およびネットワークにおける現在の Dante オーディオマルチキャスト帯域幅を

表示します。 

Status Bar（ステータスバー） 

 
Status Bar（ステータスバー）は次の情報を表示します。 

 P: プライマリーネットワークの現在のステータス緑色は Dante Controller がプライマリーネット

ワークに接続中であることを示します。赤色は接続に問題があることを示します。 

 S: セカンダリーネットワークの現在のステータスセカンダリーネットワーク接続時のみ表示されま

す。 

 マルチキャスト帯域幅: 接続中のネットワークにおける現在の Dante オーディオマルチキャスト帯域

幅です。ネットワーク上には、オーディオマルチキャスト帯域幅に読み込まれないその他のソース

機器からの信号トラフィックも存在する場合があることにご注意ください。 

 イベントログ: イベントログの現在のステータスアイコンをクリックしてイベントビューを開きます。  
 Clock Status 画面: Clock Status Monitor の現在のステータスを表示します。 アイコンをクリックし

て Clock Status Monitor を開きます。 

Network View のタブ 

Routing 画面 

Dante Controller を起動すると、Network View の Routing 画面が常に表示されます。この画面では、

ネットワークがグリッド形式で表示されます。Tx チャンネルを持つ機器はグリッドの上の行に、Rx
チャンネルを持つ機器はグリッドの左の列に表示されます。最初は各項目の内容が非表示になってい

るので、個別のチャンネルは表示されません。 

注: 機器名が赤で表示されている場合、Dante Controller がエラー状態を自動検出したことになります。

その機器名をダブルクリックして詳細を確認してください。詳細については機器エラーの自動通知を

参照してください。 

注:機器が Tx と Rx のチャンネルを持つ場合には、グリッドの上の行と左の列の両方に表示されます。 
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Routing 画面の拡張表示 

 

 

任意の機器の Rx チャンネルを表示するには、グリッドの左列の該当機器名の先頭にある[＋]をクリッ

クします。任意の機器の Tx チャンネルを表示するには、グリッド最上行の該当機器名の末尾にある

[＋]をクリックします。Network View 内のその機器の各チャンネルのグリッド表示が拡張され、[＋]
が[－]になります。[－]をクリックすると非表示になります。チャンネルを 16 セットのグループに分

けることができます。 

すべての機器の Rx チャンネルを一括して拡張表示するには、左の欄の一番上にある“[＋] [－] Dante 
Receivers”の[＋]をクリックします。同様に、すべての機器のＴx チャンネルを一括して拡張表示する

には、縦書きの一番左の列にある“[＋] [－] Dante Transmitters”の[＋]をクリックします。[－]をクリッ

クすると非表示になります。 

  

文字を入力して

その文字列を含

む機器名のみを

表示 

クリックして機

器を非表示 

クリックして

チャンネルグ

ループを非表示 

クリックして

チャンネルグ

ループを表示 

クリックしてイ

ンターフェース

を設定 

クリックして拡

張し全ての機器

と Tx チャンネル

を表示 

[Ctrl]を押しながらク

リックし可能なチャ

ンネル全てをサブス

クライブ 

クリックしてイベント

タブを開く 

クリックしてクロックステータ

スモニターを開く 

クリックして全ての

Tx 機器を拡張表示 

クリックして全ての

Rx 機器を拡張表示 
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Device List Filtering （機器リストのフィルタリング） 

左上隅の Audinate ロゴの下にある“Filter Transmitters（フィルター送信者）”と“Filter Receivers
（フィルター受信者）”のフィールドを使用してルーティング画面の機器リストにフィルターを適用で

きます。フィールド内に文字列を入力すると、フィルターによって機器名またはチャンネル名にその

文字列を含む機器のみが表示されます。  

 
フィルターでは大文字小文字の区別はありません。たとえばこちらの Network View 画面では、いず

れかの Filter フィールドに“foh”という文字列を入力すると、 FOH-Amp と FOH-Console の機器とその

チャンネルのみが表示されます。 

Channel Groups（チャンネルグループ） 

チャンネルグループをオンにすると、Network View ルーティングタブにある機器のチャンネルを 16
チャンネルごとのグループに分けられます。 

PCIe カードなど多数のチャンネルを保有する機器で、チャンネルのサブスクリプションの確認や作

成を行う場合はこの機能を使用すると便利です。 

これをオンにするには、Network view のツールバーのチャンネルグループボタン   をクリックし

ます。  

グループ名は、1..16、17..32 となります。 
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チャンネルグループを表示するには、[＋]アイコンをクリックします。チャンネルグループを非表示

するには、[＋]アイコンをクリックします。 

注: チャンネルのグループ分けはルーティングや機器の動作に影響しません。 

Device Info（機器情報） 

 
この画面では、ネットワーク全体の機器の設定と動作に関する概要情報を表示します。  

表には以下の情報が左から表示されます。 

 Device Name（機器名）: 機器に現在付けられている名前を表示します。 
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 Product Type（製品の種類）： 機器の Dante モジュールタイプを表示します。 

 Product Version（製品バージョン）： メーカーによる製品のバージョンを表示します。 

 Primary Address（プライマリーアドレス）: 機器のプライマリーインターフェースに割り当てられ

ている IP アドレスです。 
IP アドレスは DHCP によって割り当てられるか自動で自己割り当てされます。プライマリーイン

ターフェースで自己割り当てされたアドレスは 169.254.*.*の範囲です。 

 Primary Link Speed（プライマリーリンクスピード）： プライマリーネットワークのイーサネット

リンクの速度です。  

 Secondary Address（セカンダリーアドレス）: 機器のセカンダリーインターフェースに割り当てら

れている IP アドレスです。 
セカンダリーインターフェースで自己割り当てされたアドレスは 172.31.*.*の範囲です。機器がセカ

ンダリーインターフェースをサポートしていない場合は“N/A”と表示されます。機器がセカンダリー

Dante インターフェースをサポートしているが、現在接続されていない場合は“Link down（リンクダ

ウン）”と表示されます。 

 Secondary Link Speed（セカンダリーリンクスピード）セカンダリーネットワークのイーサネット

リンクの速度セカンダリーアドレスによっては他の値もあり得ます。 

注: インターフェースに優先リンクスピードがある場合、優先リンクの速度があり、プライマリーイ

ンターフェースやセカンダリーインターフェースがその優先速度で動作していないと、“Link Speed
（リンクスピード）”欄の値が赤で表示されます。 

注: 機器情報が表示されない場合は、その機器に ConMon (Dante control and monitoring service) エ
ラーがあることを示す場合があります。その場合は機器をリセットするか切り替えてください。 

Clock Status（クロックのステータス） 

 
Network View の Clock Status タブをクリックすると、ネットワーク内のクロックのステータスの概

要が表示されます。 

この画面はネットワークのクロック情報の概要を見るのに便利です。表には以下の情報が左から表示

されます。 

Device Name（機器名） 
機器に現在付けられている名前を表示します。 
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Sync（同期） 
機器のクロックの同期状態を示します。 

 緑  のランプは機器がネットワーククロックに同期しているか、または駆動させていることを示

します。 

 赤  のランプは機器が現在同期していないことを示します。 

Mute（ミュート） 
機器のミュート状態を示します。 

 赤のミュート  のアイコンは機器が現在ミュートしていること（通常クロックの同期が中断され

たこと）を示します。 

 ミュート欄に何もアイコンが無い場合は、機器がミュートしていないことを示しています。（オー

ディオ信号は正常に流れています） 

Clock Source（クロックのソース） 
機器のクロックのソースを示します。  

 Dante:  機器が、Dante ネットワークからのクロックで動作しているか、またはマスタークロックと

して機能しています。（外部ソースのクロックでは動作していません） 

 External:  機器が、外部のワードクロックで動作しています。 

Primary Status （プライマリーステータス）Secondary Status（セカンダリーステー

タス） 
プライマリーとセカンダリーのネットワークインターフェースの PTP クロックの状態を表示します。  

 Master（マスター）: 機器はプライマリーネットワークの現在の PTP “Clock Master” クロックマス

ターです。 

 Slave（スレーブ）: 機器はプライマリーネットワークの “PTP Slave” PTP スレーブです。 

 Passive（パッシブ）: 機器はこのインターフェースからクロック “Synchronization” 同期情報を利用

していません。 

 Link Down（リンクダウン）: インターフェースがネットワークに接続されていません。 

 N/A: 機器はクロックステータスの情報収集機能に対応していないことを示しています。セカンダ

リーステータス欄では、機器が非リダンダンシーであることも表示します。 

 Listening（リスニング）: 通常一時的なものです。継続して表示される場合は、その機器がクロック

マスターとしてではなくスレーブとしてのみ動作しており、ネットワーク上でのクロックマスター

の出現を待機していることを示しています。 

サンプリング周波数のプルアップ／プルダウンが設定されている機器は、クロックステータスにその

プルアップ／プルダウン値が表示されます。たとえば+0.1%のプルアップが設定されたマスターク

ロック機器は、Master +0.1%と表示されます。詳細はクロックドメインを参照してください。 

上記に掲載されていない一時的なクロックステータスもあります。 

Preferred Master（優先マスター） 
マスタークロック選定においてその機器の優先度が上がります。  

特定のクロックドメイン上で１つの機器のみの“Preferred Master”チェックボックスがチェックされて

いた場合には、そのクロックドメインではこの選択機器がマスタークロックとなります。複数機器の



Dante Controller ユーザーガイド 

  

39 
 

“Preferred Master”チェックボックスがチェックされていると、クロックマスターはその中から選定さ

れます。 

“Slave Only（スレーブのみ）”がチェックボックスに表示されている場合は、機器がマスタークロッ

クとして機能する資格がないことを示しています。 

Enable Sync To External（外部クロックとの同期） 
モジュールを強制的に外部ソースのクロックで駆動させます。（ホスト機器のワードクロックまたは

補助機器から） 

他の機器で“Preferred Master（優先マスター）”を選択していなければ、この Dante 機器がそのクロッ

クドメインのマスタークロックとなります。通常、1 つのクロックドメインに対し、2 つ以上の機器

を外部ワードクロックソースとすることはありません。この場合、同期した複数の外部ワードクロッ

クソース（例：ハウスクロック）があることが想定されます。  

チェックボックスがグレー表示され、かつ無効なとき、Dante 機器は外部ワードクロックにスレーブ

同期できますが、Dante Controller から直接設定することはできません。ホスト機器のユーザーイン

ターフェース、またはその他の手段（例：サードパーティーのコントロールソフトウェアなど）を介

して設定することが必要です。このチェックボックスがグレー表示されて、チェックが入っていると、

その Dante 機器は現在外部クロックにスレーブ同期していることを示しています。 

N/A と表示されている場合は、機器が外部ワードクロックにスレーブ設定できないことを示していま

す。 

注: クロックステータス情報が特定の機器に表示されない場合は、その機器に ConMon (Dante control 
and monitoring service) エラーがあることを示す場合があります。その場合は機器をリセットするか

切り替える必要があります。 

クロックドメイン 

サンプリング周波数のプルアップ／プルダウンが設定されていない Dante 機器は、デフォルトクロッ

クを使用してデフォルトのクロックドメイン上で動作します。サンプリング周波数のプルアップ／プ

ルダウンが設定されている機器は、別個の「クロックドメイン」で動作します。これらのドメインは

それぞれ独自の PTP クロックを持ちプルアップ／プルダウン設定されたサンプリング周波数に従っ

て調整されます。  

クロックドメインは物理的には別個のものではなく、同一ネットワークにすべて存在します。プル

アップ／プルダウン設定の機器はその設定に合ったクロックに同期し、他のクロックを無視します。

これらの機器では、Clock Status タブのクロックステータスに、そのプルアップ／プルダウン値が表

示されます。  

Dante 機器は同じクロックドメイン上の他の機器とのみオーディオの送受信を行います。たとえば、

サンプリング周波数のプルアップ／プルダウンがゼロの機器はデフォルトのクロックドメイン上での

み動作し、+4.1667%や-1%のクロックドメイン上ではオーディオの送受信ができません。 

最大 5 つまでの個別のクロックドメインが一度にサポートできます。すべてのクロックドメインはそ

れぞれ独自のマスタークロックを持ちます。 

マスタークロック 

“Grand Master”とも呼ばれるネットワークのマスタークロックが Network View のツールバーの中心に

常時表示されます。これはネットワーク上のすべての機器にタイムシンクソースを供給している機器

です。 

複数のクロックドメインを使用している場合、各ドメインのマスタークロックがカンマで区切られて

表示されます。 
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マスタークロックは選出プロセスにより自動的に選択されますが、選択上の優先順位を設定できるパ

ラメーターがあります。外部ワードクロックソースが入力されるように機器を設定すると、別の機器

が“Preferred Master”に設定されていない限り、その機器がマスタークロックになります。 

“Preferred Master”にチェックを入れると、その機器（または複数機器でチェックが入っている場合は

MAC アドレスの一番小さい機器）が、常に該当ドメインのマスタークロックになります。 

注: マスタークロックが Dante Controller から直接認識されないとき、たとえばマスタークロック機器

が何らかの理由でセカンダリーネットワークのみに接続され、Dante Controller がプライマリーネッ

トワークのみに接続されている場合はツールバー上でのマスタークロックの表示は、機器名ではなく

MAC アドレスの文字列になります。 

Clock Status Monitoring（クロックステータスモニター） 

対応機器がネットワークのマスタークロックに対し、同期を確立しているかどうかを Dante 
Controller でモニターします。  

モニターには Passive（パッシブ）と active（アクティブ）の 2 種類のレベルがあります。  

パッシブモードでは、Dante Controller はマスタークロックとの同期が外れた場合、または同期が復

帰した場合に通知します。  

アクティブモードでは、Dante Controller は上記の場合に加えて、機器のクロック同期が不安定な兆

候を示した場合にも通知します。機器のクロックが不安定な状態になるとマスタークロックとの同期

が外れることがあり、結果としてその機器は自動的にミュートされます。 

機器のクロックはなぜ不安定になる？ 
機器の“Clock Stability（クロックの安定性）”に影響を及ぼす要因として、以下のような様々なネット

ワーク状況があります。たとえば、 

 Energy Efficient Ethernet (省電力型イーサネット、いわゆる「グリーンイーサネット」）機能を使用

するようにネットワーク上のスイッチが設定されている場合 

 ギガビット接続が必要なのに 100 Mb のスイッチまたはリンクが存在する場合 

 1 つまたは複数のスイッチが正しく設定されていない場合 

 問題のある外部ワードクロックがマスタークロックとして使用されている。 

詳細については Dante FAQ を参照してください。 

Passive（パッシブ）モニター 

パッシブモニターは常時稼働しています。パッシブモードでは、Dante 機器のマスタークロックとの

同期外れや、同期の復帰を Dante Controller へ通知します。Dante Controller はこれらの問題をログ

ファイルに記録し、同時に通知を表示します。メイン画面の右下端にあるクロックステータスモニ

ターアイコンが赤に点灯します。 

 

http://dev.audinate.com/kb/webhelp#dante_controller/dante_controller_displayed_a__clock_instability_detected__popup___why_is_this.htm
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アイコンをクリックすると、クロックステータスモニターが開きクロックステータスのイベントログ

とヒストグラムを確認できます。 

アクティブモニター 

アクティブモニターがオンになっていると、Dante Controller は能動的に対応機器の動作をモニター

して、クロックに不安定の兆候があるか確認します。クロックが重大な不安定性を示した場合、ク

ロックステータスモニターアイコンがオレンジに点灯し、クロックステータスイベントログに警告イ

ベントとして記録されます。 

 
アイコンをクリックしてクロックステータスモニターを開きます。 

初期設定ではアクティブモニターはオフになっています。これをオンにするには、メインツールバー

のクロックステータスモニターボタンをクリックします。  

クロックステータスモニターがオンになると、ボタンは緑に点灯します。 

 
オフにするには、このボタンをもう一度クリックします。 

注: アクティブモニターはパッシブモニターに影響しません。 

対応機器の種類 
Dante PCIe カード、Dante-MY16-AUD カード、Ultimo（少数チャンネル）機器、および Brooklyn II 
Dante モジュールを含む機器がアクティブモニターをサポートしています。   

お使いの機器が Brooklyn II 機器の場合は、 Device View > Status タブの Dante Information（Dante 情

報）欄に Model タイプとしてそれが表示されます。 

Clock Status 画面 

Clock Status 画面には Log と History の 2 つのタブがあります。 
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Log 

Clock status の log は、不安定と認識された機器やマスタークロックとの同期が外れたり復元された

りした各デバイスについて、タイムスタンプがついたクロックステータスのイベントを表示します。 

 
イベントには次のタイプがあります。 

 Clock Sync Warning（クロック同期警告）：クロックが不安定であると認定され、マスタークロッ

クとの同期が外れる危険性があることを表示します。 

 Clock Sync Unlocked（クロック同期がロックしていない状態）：機器のマスタークロックとの同期

が外れたことを表示します。この機器は同期を復元するまで自動的にミュートされます。 

 Clock Sync Locked（クロック同期がロックしている状態）：機器のマスタークロックとの同期が復

元されたことを表示します。 

クロックステータスのログエントリーを削除するには、Clear をクリックします。クロックステータ

ス画面のアイコンはリセットされ緑に変わります。  

注: 同時に他のイベントログエントリーもすべてクリアされます。（クロックステータスログはメイ

ンイベントログにフィルターを適用した画面です） 

Dante Controller はクロックステータスモニターボタンがオフでない限りモニターを再開します。 

イベントログを xml ファイルに保存するには、Save をクリックします。 

History 

History タブは機器のクロックの安定性を確立するのに使用します。“Clock frequency offset” （クロッ

クの周波数オフセット）のヒストグラムでは、選択した機器でのクロックの周波数オフセットのヒス

トグラムと、現在の周波数のオフセット値をリアルタイムでアップデートして表示します。 

以下の情報もあわせて表示されます。 

 Mute Status（ミュートステータス） 

 Sync Status（同期ステータス） 

 External Word Clock（外部ワードクロック） 

 Preferred Master status（優先マスターのステータス） 
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“Clock offset”（クロックのオフセット）について 
ハードウェアクロックは圧電振動水晶クォーツを基盤としています。水晶の微妙な個体差により、振

動周波数には多少の誤差が見られます。機器の「スレーブ」クロックがネットワークのマスターク

ロックに同期を試みるとき、その周波数はマスタークロックの周波数に合わせるためプルアップ／ダ

ウンする必要があります。このクロック周波数の調整値を“offset（オフセット）”と呼びます。 

ハードウェアクロックは“pull range（調整範囲）”と呼ばれる、限られたオフセット値しかサポートで

きません。調整範囲を超えるとスレーブクロックはマスタークロックとの同期がはずれ、自動的に

ミュートされます。  

通常ソフトウェアのクロックはアルゴリズムを使用して、内部カウンターからクロックを得ています。

ソフトウェアクロックについてはオフセット値の制限はありません。  

オフセットの急激な変化はスレーブクロックにおいてマスタークロックとの同期が外れる原因にもな

ります。  

スレーブクロックのオフセットに影響して不安定性を誘発する原因は下記のようにさまざまです。  

 ネットワークリンクのオーバーロード 

 不完全に実装された EEE (Energy Efficient Ethernet) 

 マスタークロックが公称周波数で駆動していないなど、正確でない外部ワードクロックで駆動して

いる。 

ヒストグラムについて 
ヒストグラムの水平軸はクロックの公称周波数に対する周波数オフセットの計測分布です。単位は、

100 万分の 1（ppm）です。水平軸の 0 地点はクロックの公称周波数に相当します。（クロックを駆

動させたい周波数 – 例：98kHz） 

垂直軸は各データ地点で記録された計測数が対数目盛で表示されます。  

 
計測はほぼ毎秒ごとに行われ、ヒストグラムは継続的にアップデートされます。 

 機器を選択するには最上部のドロップダウンメニューをクリックします。 

 ヒストグラムをクリアするには、Clear をクリックします。  

 Save をクリックすると、現在のデータのスクリーンショットを png 形式で保存します。 
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ヒストグラムの解析 
ヒストグラムでは、スレーブクロックがマスタークロックとの同期を維持するため行った作業量を見

ることができます。 

正確で安定しているクロックは、2～3ppm 以内の変動にとどまる常に安定したオフセットを示します。

つまり同期を維持するのにオフセットの変更をそれほど必要としないことを意味します。 

ヒストグラムの例 

 
オフセット範囲の分布が散見されるヒストグラムは、クロックが不安定であることを示します。マス

タークロックとの同期を維持するためオフセットの大がかりな変更をたびたび実行しています。ネッ

トワークリングのオーバーロードや不完全に実装された EEE がその原因と考えられます。このよう

な状態にある機器はマスタークロックとの同期が外れる可能性大と考えられます。 

ヒストグラムの例 
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ヒストグラムの計測値がオレンジか赤またはその両方で表示されるとき、クロックは現在かろうじて

安定しているが調整できる余地はそれほどなく、オフセットが容易に調整範囲を超えて、完全に同期

がはずれる可能性があることを示します。マスタークロックが不正確な外部ワードクロックで駆動し

ている場合、このような状態になります。 

注: Dante Controller は、クロック状態のデータを収集するために、数日間（または数週間でも）動作

させることができます。これにより、ネットワークでのクロック設定の安定性を長期間、画像で観測

することができます。 

ヒストグラムの例 

 

Network Status（ネットワークステータス） 

 
ネットワークステータスタブでは、ネットワーク上のすべての機器におけるネットワーク関連の情報

を提供します。 

この画面には、サブスクリプションステータス、帯域幅、レイテンシー情報が含まれ、ネットワーク

トラフィックで起こりうる問題をすばやく確認できます。 

表には以下の情報が左から表示されます。 

Device Name（機器名） 
機器に現在付けられている名前を表示します。 
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Subscription Status（サブスクリプションステータス） 
サブスクリプションステータス欄のアイコンは、サブスクリプションステータスの概要を表示します。

うまくサブスクリプションされていないチャンネルがある場合、該当のアイコンがここに表示されま

す。 

サブスクリプション欄に表示されるアイコンについての情報はオーディオチャンネルのサブスクリプ

ションを参照してください。 

Primary Status（プライマリーステータス） 
プライマリーステータス欄には、プライマリーネットワークインターフェースのリンクスピードが表

示されます。 

Secondary Status（セカンダリーステータス） 
セカンダリーステータス欄には、その機器へのセカンダリーネットワークインターフェースのリンク

スピードが表示されます。（ある場合のみ）機器にセカンダリーインターフェースがない場合は“N/A”
と表示されます。機器にセカンダリーインターフェースがあるが、現在接続されていない場合は“Link 
Down（リンクダウン）”と表示されます。 

Bandwidth-Columns（帯域幅欄） 
帯域幅欄では、各機器のインターフェース経由で送受信されるトラフィックの概算が確認できます。 

 Primary Tx B/W（プライマリー Tx B/W） 

プライマリー Tx B/W 欄には、プライマリーネットワークインターフェースの現在の送信帯域

幅の概算が表示されます。 

 Secondary Tx B/W（セカンダリー Tx B/W） 

セカンダリー Tx B/W 欄には、セカンダリーネットワークインターフェースの現在の送信帯域

幅の概算が表示されます。 

 Primary Rx B/W（プライマリー Rx B/W） 

プライマリー Rx B/W 欄は、プライマリーネットワークインターフェースの現在の受信帯域幅

の概算を表示しています。 

 Secondary Rx B/W（セカンダリー Rx B/W） 

セカンダリー Rx B/W 欄には、セカンダリーネットワークインターフェースの現在の受信帯域

幅の概算が表示されます。 

レイテンシー設定 
機器の現在のレイテンシー設定を示します。 

Latency Errors（レイテンシーエラー） 
レイテンシーエラー欄には最近のレイテンシー性能を表すアイコンが表示されます。 

 緑のランプは機器がサブスクリプションされ、レイテンシーに問題がないことを示します。

オーディオパケットはすべて機器のレイテンシー設定内で到着しています。 

 オレンジのランプは 1 つ以上のチャンネルでオーディオパケットが機器のレイテンシー設

定の上限またはそれに近い状態で到着していることを示します。機器のレイテンシーを上げ

るか、オーディオパケットの延着に伴うパケットロスによる音切れ防止のためネットワーク

を再構築する必要が生じる可能性があります。  
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 赤のランプは 1 つ以上のオーディオパケットが機器のレイテンシー設定の範囲外で到着し

たことを示します。これにより音切れが発生することがあります。機器のレイテンシー設定

を上げるか、または送信機と受信機間のネットワークノード数を減らすなどの方法でネット

ワークを再構築する必要があります。 

 グレーのランプは機器が現在サブスクリプションされていないことを示します。 

Packet Errors（パケットエラー） 
パケットエラー欄の赤のランプは 1 つ以上のオーディオパケットがスイッチと受信機間で破損したこ

とを示します。通常イーサネットケーブルの欠陥が原因です。 

Device View > Status タブにある“Clear Counters” ボタンを使うと、機器のパケットエラー履歴を消去

できます。 

Events（イベント） 

 
Events 画面にはネットワークの重要な変更内容と故障情報が表示されます。 

Dante Controller は Dante 機器とネットワークを常時全体的にモニターしています。問題のある設定、

想定外の問題点、および Dante 機器間の通信異常を監視します。イベントは表示されイベントログに

保存されます。  

イベントは次の 3 つのカテゴリーの内の 1 つに分類されます。Information（情報）、Warning（警

告）、Error（エラー） 

Device List Filtering （機器リストのフィルター機能） 
イベントリストにフィルターをかけるには画面左下のドロップダウンメニューを使用します。 
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 Information に設定するとすべてのイベントが表示されます。 

 Warning に設定すると警告とエラーのみが表示されます。 

 Error に設定するとエラーのイベントのみが表示されます。 

Clearing the Event List （イベントリストのクリア） 
イベントリストをクリアするには、Clear ボタンを押します。現在のフィルター設定にマッチする新

規のイベントが検出されると、イベントリストに表示されます。  

他の Network View タブに切り替えると、イベントリストにある新規のイベントも ステータスバーの

赤のイベントログ LED によって表示されます。LED アイコンをクリックするとイベントタブに切

り替わり、イベントログ LED をクリアします。 

注: イベントタブが緑の時は、イベントログ LED も常に緑のままとなります。 

イベントログの保存 
イベントリストを保存するには、Save ボタンを押します。リストは拡張子.log を伴いテキストファイ

ルとして保存されます。リストにあるすべてのイベントが保存されます。（保存されたイベントログ

にはフィルター機能はありません） 

自動イベントログ 
イベントは同時にログファイルにも書き込まれます。Dante Controller が起動するたびに、以前のロ

グを上書きしないよう、ファイル名にタイムスタンプを付けた新しいログファイルが作成されます。  

これらのログへのパスは Help > About で確認できます。Delete old Log files ボタンで 7 日前より古い

ログファイルを削除することができます。 

イベントの分類 
次のイベントは Error（エラー）に分類されます。 

 無効なリンクローカルアドレス 

 Dante インターフェースでのサブネットの不適合 

 非 Dante インターフェースでのサブネットの適合 

 適合しているサブネットに複数のアドレス 

 プライマリーにおける Dante インターフェースでのサブネット競合 

 セカンダリーにおける Dante インターフェースでのサブネット競合 

 不明なアドレスのエラー 

 フェイルセーフモード 

 不明な機器の問題 
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 クロックマスターへの昇格 

 端末増設設定の検知 

 クロックプルアップのサブドメインの不適合 

 プルアップに不適切なサブドメイン 

 不明なサブドメイン 

 オーディオミュート／オーディオミュート解除 

 クロック同期のロック／ロック解除 

次のイベントは警告に分類されます。 

 処理失敗 

 Grand Master への格上 

 複数の外部クロックソース 

 クロックマスターへの格上不可 

 Clock Sync Warning（クロック同期警告） 

次のイベントは Information（情報）に分類されます。 

 タイムアウトエラーのリクエスト 

 タイムアウトエラーへの応答 

 クロックマスターからの降格 

 Grand Master からの降格 

 再起動要求 

機器 エラーの自動通知 

Dante Controller は Dante 機器に生じる可能性のあるいくつかのタイプの問題を識別できます。問題

のあることがわかった機器の名前は赤字で表示されます。問題の詳細はその機器名をダブルクリック

して確認できます。 

赤字表示の機器はフェイルセーフモードに入っているか、IP 設定で問題が生じています。これについ

ては以下で詳細に説明します。 

オレンジ色の文字表示は機器（Ultimo 少数チャンネル機器のみ）がアップグレードモードに入ってい

ることを意味します。（以下参照） 

不正な IP アドレス設定 

Dante ネットワークは IP アドレス方式で通信します。不正なアドレス設定があると、Dante 機器の通

信が困難または不可能になります。Dante Controller は以下のような不正な IP アドレスのタイプを識

別し通知します。 

 同一ネットワーク上に複数の DHCP サーバーが存在する 

 静的 IP アドレスの設定ミス 

 Dante 機器のセカンダリーインターフェースがプライマリーネットワークに接続されている 

 同一機器上に、同じ IP アドレスサブネットを使用した異なるインターフェースが存在する 
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 プライマリーネットワークの DHCP サーバーを、セカンダリーリンクのローカル機器に保存されて

いる IP アドレスの範囲で設定した場合 

詳細はセクションを参照してください。 

フェイルセーフモード 

カード上に保存されているファームウェアのイメージが壊れると、フェイルセーフモードに入ります。

稀ですが以下の場合に生じることがあります。 

 停電またはネットワークの故障によりファームウェアの更新が中断した場合 

 更新データに使用されている ファームウェアのイメージ自体が壊れている場合 

お使いの機器がフェイルセーフモードに入った場合は、（利用可能であれば）Firmware Update 
Manager アプリケーションの Failsafe Recovery（フェイルセーフリカバリ）機能を使用するか、お

使いの機器のメーカーにご連絡ください。 

アップグレードモード 

使用中の Ultimo 機器（技術的には、内部イーサネットスイッチを含むもの）がアップグレードしてい

るとき、またはアップグレードを完了したがまだ再起動されていないとき、その機器は「アップグ

レードモード」にあり、Dante Controller ではオレンジ色の文字で表示されます。このモードのとき

は、Device View に Issues タブが表示され問題の機器の現在の状態を示します。 

これらの機器に新しいファームウェアを適用させるためには、Dante Controller を介してユーザーに

より「手動」で再起動させる必要があります（アップグレード処理として自動的に再起動するような

他の機器とは異なります）。その理由は、ある機器が自動でアップデートした場合、その機器が再起

動中している間にその機器を介してデイジーチェーン接続の下流の Dante 機器にオーディオやファー

ムウェアの更新データが送信されないためです。手動再起動のオプションにより、機器の再起動タイ

ミングをユーザーが選択でき、以下のような問題の発生を防止することができます。 

 思いがけずデイジーチェーン下流のすべての接続機器へのオーディオが中断されること 

 たまたま下流のデイジーチェーン接続の機器もファームウェア更新中の場合、更新データが中断さ

れるとそれらの機器はアップデート失敗となり、機器がフェイルセーフモードに陥ること 

機器が再起動したら、すべての下流のデイジーチェーン接続機器へのオーディオの流れは自動的に再

開されます。 

その他のイベントの通知 

Dante Controller は Status Bar の LED アイコンでネットワークステータス、一般機器のイベント、ク

ロックステータスイベントも通知します。 

Device View 

Device View では特定の機器についての詳細な情報と設定の表示および変更を行います。Device View
を表示するには、いずれかの Network View 画面（Event 以外）内にある機器名をダブルクリックする

か、Network View ウインドウの Device メニュー（Ctrl + D または Command + D）から Device View
を選択します。新しいウインドウに Device View が表示されます。複数の Device View が同時に開き

ます。 
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注: Mac OS X ユーザー：以下のキーの組合せは Windows 用です。Mac コンピュータで Dante 
Controller をお使いの場合は、以下の手順において Ctrl キーの代わりに“Command ”キーまたは“Apple”
キーを、また該当する場合は標準の Mac のキーの組合せを使用してください。詳細は Dante 
Controller メニューをご覧ください。 

 
確認対象の機器のラベルはツールバー中央に表示されます。上の画面例では FOH-Console がドロッ

プダウンリスト内に表示されています。 

別の機器を表示するには、ドロップダウンリストからその機器を選択します。 

Network View から複数の Device View ウインドウを開いて、複数の機器を同時に確認することができ

ます。 

Device View には以下のタブのいくつかまたは全部が表示され、特定の Dante 機器について各種情報

を見ることができます。 

 Receive：機器の受信(Rx)チャンネルを表示、設定します。 

 Transmit：マルチキャストを含む機器の送信(Tx)チャンネルを表示、設定します。 

 Status： 機器のソフトウェア、クロック、ネットワークのステータス情報を表示します。 

 Latency：レイテンシーヒストグラム（対応機器のみ）を表示します。 

 Device Config：機器名の変更、サンプリング周波数の変更、（機器タイプに関連した）その他の属

性を設定します。 

 Network Config：ネットワークの設定を表示、編集します。 

 Issues：フェイルセーフモードまたはアップグレードモード（Ultimo 少数チャンネル機器のみ）に

なっている機器の情報を表示します。通常は表示されません。 
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 Baseboard：Dante 機器が Dante PDK オーディオベースボードに搭載されているときにのみ表示さ

れます。（注: 機器は SPI マスターモードであることが必要です） 

Device View のメニューバー 

Device View のメニューバーには以下のメニューがあります。 

File 
 Close Window 

Device 
 Refresh: 表示されているネットワーク／機器データを更新します。 

 Multicast Flow を作成します。 

View 
 Show/Hide Channel Groups 

Help 
 About: Dante Controller のバージョンと現在のログファイルを表示します。 

 License: 使用許諾契約のテキストを表示します。 

 Contents: ヘルプウインドウを開き、ヘルプ項目を表示します。 

Device View のツールバー 

Device View ツールバーには以下のボタンが含まれます。 

 

 
更新 現在の機器に関するルーティング／設定情報を更新しま

す。 

 
ウェブ設定 一部の Dante 機器はウェブインターフェースから設定で

きます。このボタンでウェブブラウザウインドウを開き、

ファームウェアの更新などの機能を実行します。この機能

は必ずしもすべての Dante 機器が対応しているわけでは

ありません。  

 
識別 このボタンを押すことで、たとえば機器のインジケータを

点滅させるなど、現在選択している機器を識別できます。

この機能は必ずしもすべての Dante 機器が対応している

わけではありません。 

 
マルチキャスト 
 

現在の機器の multicast transmit flows（マルチキャスト送

信フロー）を設定します。 

 
Channel Groups 
（チャンネルグループ） 

Channel Groups（チャンネルグループ）を表示/非表示し

ます。 

 

ツールバーにはネットワーク上で利用可能なすべての機器を掲載したドロップダウンリストもあり、

Device View を別の機器に切り替えることができます。 
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Device View タブ画面 

Device View はいくつかのタブに分割されていて、ある機器にしか適用しないものもあります。それ

ぞれのタブの画面については以下で詳細に説明します。 

Receive タブ 

Receive タブは現在の機器上でサブスクリプションされ、休止しているすべての送信チャンネルのリ

ストに加え、サブスクリプションされているチャンネルのサブスクリプション情報も表示します。ま

た、Available Channels リストからサブスクリプションを作成することもできます。  

 
このタブの画面は２つの欄に分割されています。 

Receive Channels（受信チャンネル）と Available Channels（利用可能チャンネル）です。 

Receive Channels（受信チャンネル） 
受信チャンネル欄は４つのフィールドを含んでいます。 

 Channel（チャンネル）：現在の機器の受信チャンネルラベルを示します。これらをここで編集して

チャンネル名を変更することができます。 

 Signal（信号）： 対応機器には以下のチャンネルメーターアイコンが表示され、サブスクリプショ

ンのあるチャンネル上にオーディオ信号があることを示します。 
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 チャンネルがミュートされているか、レベルが-61dbFS 未満のオーディオを受信し

ています。 

 レベルが-61dbFS～0dfFS のオーディオを受信しています。 

 クリッピングしています。 

 

チャンネルメーター対応機器の種類 
Dante Controller では現在 Brooklyn II と PCIe 機器がチャンネルメーター対応しています。Device 
Info タブの機器タイプがチェックできます。 

 Connected To（接続先）: 受信チャンネルの現在のサブスクリプション先の送信チャンネルを表示し

ます。 

 Status（ステータス）: プライマリーとセカンダリーのサブスクリプション状態を以下のアイコンを

使用して表示します。 

 

 サブスクリプションに問題なく、オーディオ信号が伝送されます。 

 サブスクリプションが不完全です。通常、送信機がネットワークから外されたり

電源が切れたりなどが原因です。 

 サブスクリプションがないかエラーが生じています。 

 ユニキャスト接続のサブスクリプションです。 

 マルチキャスト接続のサブスクリプションです。 

 

サブスクリプションは Status 欄に複数のアイコンを表示します。アイコンの組合せと意味は以下の通

りです。 

 

 
機器がユニキャストで送信機にサブスクリプション設定されています。 

 リダンダンシー対応機器がプライマリーとセカンダリーの両方を通じてユ

ニキャストでサブスクリプションされています。  

 リダンダンシー対応機器がプライマリーとセカンダリーの両方を通じてマ

ルチキャストでサブスクリプションされています。  

 リダンダンシー対応機器がプライマリーのみを通じてユニキャストでサブ

スクリプションされています。セカンダリーインターフェースが接続され

ていない時によくあります。 

 

Available Channels（利用可能チャンネル） 
Available Channels（利用可能チャンネル）欄はネットワーク上で利用可能な機器および通知されて

いるチャンネルを表示します。グレー表示の機器はこの受信機がこれらのチャンネルまたは機器をサ

ブスクリプションすることができないことを示します。これは通常、パラメーターの不一致（サンプ

リング周波数の不適合など）や、1 つの機器内部で送受信のルーティングは不可能であることなどが

原因です。 
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多くのチャンネルがある機器では、Channel Groups ボタンをクリックして利用可能チャンネルを 16
チャンネルごとのグループに分けることができます。 

サブスクリプションの作成 
サブスクリプションを設定するには、Receive 画面右枠の Available Channels リストからチャンネル

を選択した後、画面左枠内の適切な受信チャンネルにドラッグ＆ドロップします。 

複数のサブスクリプションを一括設定するには、複数チャンネルを選択した後、受信チャンネルにド

ラッグ＆ドロップします。チャンネルグループをドラッグ＆ドロップして一括サプスクリプション設

定することもできます。 

Receive Channel Labels（受信チャンネルラベル）の変更 
受信チャンネルラベルを変更するには、ラベルをクリックして新しいラベルを入力します。 

Transmit タブ 

Transmit タブでは機器の送信設定の確認と変更を行います。 

 
Transmit タブの画面は２つのセクションに分かれています。 

 Transmit Channels（送信チャンネル）: 画面左枠内は機器の Tx チャンネルとユーザーが定義した

チャンネルラベルを表示します。送信チャンネルのラベルを作成することができます。チャンネル

ラベルに無効な文字が使用されないよう、表への入力にはフィルターがかけられます。 

対応機器には Signal（信号）欄に以下のチャンネルメーターアイコンが表示され、サブスクリプ

ション設定されたチャンネル上にオーディオ信号があることを示します。 
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 チャンネルがミュートされているか、レベルが-61dbFS 未満のオーディオを受信し

ています。 

 レベルが-61dbFS～0dfFS のオーディオを受信しています。 

 クリッピングしています。 

 

 Transmit Flows（送信フロー）: 画面右枠は、現在使用中のユニキャストフローの数と、その機器に

設定されたマルチキャストの送信フローを表示します。マルチキャストのフローは、そのフロー内

に含まれているチャンネルを含め、ID 順に表示されます。 

注: ユニキャストフローの詳細は送信フローウインドウには表示されません。現在使用中の送信フ

ローの総数は画面上部に表示されます。送信フローの総数は使用中のユニキャストとマルチキャスト

のフローの合計です。機器が対応可能なフローの最大数も表示されます（上の画面では 32）。 

Tx チャンネルラベルの変更 
Tx チャンネルのラベルを変更するには、ラベルをダブルクリックして新しいラベルを入力します。

Tx チャンネルのラベル名は１つの機器内で重複することはできません。 

Status タブ 

Status タブは Dante 機器についての現在の情報が表示されます。 

 
この画面は複数のセクションに分かれています。Status 画面に表示される情報はシステムのネット

ワークやクロックの問題を調べる際に非常に有効です。必要に応じて、更新ボタン でこの情報を

更新できます。 
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注: Dante 機器によっては、このすべての情報が必ずしも表示されないことがあります。 

Device Information（機器情報） 
機器についての以下の一般的な情報を表示します。 

 Manufacturer（メーカー）: 機器メーカー名を表示します。 

 Product Type（製品の種類）: 機器のタイプを表示します。 

 Product Version（製品バージョン）: 製品のバージョンを表示します。 

  Software Version（ソフトウェアバージョン）: この機器で動作しているソフトウェア製品のバー

ジョンを表示します。 

 Firmware Version（ファームウェアバージョン）: この機器で動作している製品のファームウェアの

バージョンを表示します。 

Dante Information（Dante 情報） 
この機器についての Dante 関連情報を表示します。 

 Model（モデル）: Dante 機器のタイプを表示します。 

 Software Version（ソフトウェアバージョン）: この機器で動作している Dante ソフトウェアのバー

ジョンを表示します。 

 Firmware Version（ファームウェアバージョン）: この機器で動作している Dante ファームウェアの

バージョンを表示します。 

Clock Synchronization（クロック同期） 
機器のクロックについて以下の情報を表示します。 

 Mute Status（ミュートステータス）: Muted は、クロックの同期に関する問題が生じたり外部ワー

ドクロックが無効なために機器が自動的にミュートされていることを示します。Unmuted は機器が

ミュートしておらず、オーディオ信号が正常に流れていることを示します。 

 Sync Status（同期ステータス）: Locked は機器がネットワーク PTP クロックにロックしていること

を示します。Not Locked はインターフェースがネットワーク PTP クロックとのロックを達成してい

ないことを示します。 

 External Word Clock（外部ワードクロック）No は機器が内部クロックソースを使用するように設定

されていることを示します。Yes は機器が外部クロックソースを受け入れるように設定されている

ことを示します。 

注: Dante 機器が外部クロックソースを受け入れるように設定されている場合には、ホスト機器が

ワードクロックを Dante 機器に供給する設定になっていることを必ず確認してください。詳細はお

使いの製品の説明書を参照してください。 

 Preferred（優先）: No は機器が優先マスターモードに設定されていないことを示します。Yes は機

器が優先マスターモードに設定されていることを示します。 

 Frequency Offset（周波数オフセット）: ネットワーククロックマスターからの補正率を ppb（10 億

分の 1 を基準とする割合）単位で示します。 

Primary Interface（プライマリーインターフェース） 
プライマリーネットワークインターフェースについての以下の情報を表示します。 

 IP Address（IP アドレス）インターフェースに現在割り当てられている IP アドレスを表示します。 

 MAC Address（MAC アドレス）: インターフェースのイーサネット層の MAC アドレスを表示します。 
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 Tx Utilization（Tx 利用度）: 現在使用中の送信総帯域幅を表示します。 

 Errors（エラー）:（Tx Utilization の右）機器を最後に起動してから検出した送信サイクリック・リ

ダンダンシー・チェック（CRC）またはパケットエラーの数を示します。 

 Rx Utilization（Rx 利用度）: 現在使用中の受信総帯域幅を表示します。 

 Errors（エラー）:（Rx Utilization の右）機器を最後に起動してから検出した受信サイクリック・リ

ダンダンシー・チェック（CRC）またはパケットエラーの数を示します。 

注: Rx Utilization には Dante 機器へ伝送されるネットワークトラフィックだけでなく、このネット

ワークインターフェースで受信するその他の任意のマルチキャスト／ブロードキャストトラフィック

も含まれます。 

注: 良好なクロック同期性能を確保するための基本は、Rx と Tx の利用度がいずれもリンク速度の

85%を越えないことです。 （リンクはフルデュプレックス動作しています。） 

グラフィックも以下のようにインターフェースの速度と接続ステータスを示します。 

 

 

インターフェースリンクが 1 Gbps で動作していることを示します。 

 

インターフェースリンクが 100 Mbps で動作していることを示します。 

 

インターフェースが接続されていないか、エラーが生じています。IP アドレ

ス欄には N/A と表示され、Tx と Rx の利用度は 0 kbps です。 

 

 Clear Counters（カウンターのリセット）: このボタンを押すと機器のパケットエラー履歴が消去さ

れます。 

Secondary Interface（セカンダリーインターフェース） 
上述のプライマリーインターフェースと同じ情報をセカンダリーインターフェースについて表示しま

す。 

注: セカンダリーネットワークインターフェースは機器がリダンダンシーに対応している場合にのみ

表示されます。 

Latency タブ 

対応機器では、Latency タブで機器がサブスクリプションされている先の各送信機のオーディオパ

ケットレイテンシーのヒストグラムを表示します。 

レイテンシーモニタリング対応機器の種類 
Dante Controller では最新の Brooklyn II、PCIe と Ultimo 機器がレイテンシーモニタリング対応してい

ます。Device Info タブの機器タイプがチェックできます。 
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レイテンシーとパケットロスについて 
レイテンシーは、信号が送信機からネットワークを介し（潜在的に複数のスイッチを通って）受信機

に到達するまでにオーディオパケット間に生じる遅れを測るために使用されます。  

受信機のレイテンシー設定が過小だと、再生されるべきオーディオパケットが送信機から受信機に到

達する時間が少なすぎます。この問題が発生した場合、受信機はパケットを消失します。（つまり、

パケットが受信機に“乗り遅れる”ため消失してしまいます。） 

パケットロスは音切れにつながるので、すべての受信機がパケットロスを防止するために十分な高さ

にレイテンシーを設定することが重要です。 

しかし、機器レイテンシーの設定を過大にすると、低レイテンシーアプリケーション（たとえば、

ボーカルを録音するときのリアルタイムモニタリング）に影響することもあるので、低レイテンシー

とオーディオ全体のバランスに注意が必要です。 

Latency タブは以下の点を確認することもできます。  

 レイテンシーが過小に設定されているため、パケットを消失している機器 

 レイテンシーが過小に設定されているため、パケットを消失する危険性のある機器 

 レイテンシーを小さくすることができるかもしれない機器（必要な場合、通常、低レイテンシーの

アプリケーションには、Dante のデフォルトレイテンシーである１ms で十分です。） 

ヒストグラムについて 
送信機名はヒストグラムの上に、ヒストグラムが報告しているレイテンシー値と一緒に表示されます。 

水平軸は送信機からのオーディオパケットレイテンシー測定値の分布を示します。垂直軸は各データ

ポイントで記録された測定値の数を対数スケールで示します。 

測定値は Dante Controller が起動してからおよそ１秒間隔で得られます。 

 
ヒストグラムを消去するには Clear をクリックします。レイテンシー測定が再スタートします。  
ヒストグラムを png 画像として保存するには Save をクリックします。 

注: サブスクリプションがマルチキャストの場合、1 台の送信機に２つのヒストグラムが表示されるこ

とがあります。ユニキャストフロー用とマルチキャスト用です。なぜならマルチキャストフローは常
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に 1ms のレイテンシーを使用するからです。受信機が 1ms 以外のレイテンシーに設定されている場

合、２つのヒストグラムが表示されます。  

以下の情報も表示されます。 

 ヒストグラム用レイテンシー設定: ほとんどの場合、受信機でのレイテンシー設定と同じです。しか

し、サブスクリプションの中には、Dante が自動的に異なるレイテンシーを適用するものもありま

す。例:  

o マルチキャストフローは自動的に 1ms に設定されます。 

o もし送信機が受信機に設定されたレイテンシーに対応しない場合（要求されたレイテンシー以

内の送信が保証されない場合）、Dante は送信機で対応できる最少の設定のところまでレイテ

ンシーを上げます。たとえば、Ultimo 機器は最小レイテンシーとして 2ms に対応しているので、

Ultimo 機器のサブスクリプションは最小でも 2ms を使用します。 

 測定を始めてからの Peak レイテンシー 

 測定を始めてからの Average レイテンシー 

 1 つ以上の Late パケットを含んだ測定値の数（一般的に、それぞれの測定値は複数のパケットを含

んでいます。） 

ヒストグラムを解釈する 
すべてのバーが緑色で、ヒストグラムの範囲内（左側か中央）にうまく入っていれば、受信機のレイ

テンシー設定はパケットロスを防止するのに十分な高さに設定されていることを示します。 

例 

 
もしバーのどれかがオレンジ色なら、いくつかのパケットがレイテンシー設定の限界近くまで到達し

ていることを意味します。ネットワークトラフィック変動によってパケットが遅れて到着する原因を

引き起こしかねません。このタイプのヒストグラムは可能であれば、受信機のレイテンシーを増やさ

なければならないことを示しています。 
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例 

 
もしバーのどれかが赤色なら、パケットのロスとオーディオロスを示します。受信機レイテンシーを

増やすか、ネットワークを再設定してください。 

注: Dante Controller は、クロック状態のデータを収集するために、数日間（または数週間でも）動作

させることができます。これにより、ネットワークでのクロック設定の安定性を長期間、画像で観測

することができます。これは特にネットワークのインフラをアップグレードした後や、ネットワーク

に新たな端末を増設した後に、ネットワークスイッチのレベルで QoS 調整をするべきかキャパシ

ティを増強するべきか判断する際に便利です。  

例 
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Device Config タブ 

Device View ウインドウの Config タブでは機器別のパラメーター設定ができます。設定内容は機器の

機能によって異なります。機器が Dante Controller からの設定に対応しない場合、この画面は使用で

きません。 

注: Dante Virtual Soundcard には Dante Controller で使用できる Config タブがありません。パソコン

上の Dante Virtual Soundcard ユーザーインターフェースを使用し設定してください。 

 

設定可能パラメーター 

Rename Device（機器名変更） 
機器に新しい任意の名前を付けることができます。テキスト欄には現在の名前が表示されます。 

機器名を変更するには、テキスト欄に新しい名前を入力し Enter を押します。 

名前の重複や機器名の規則についての詳細は、機器名とチャンネルラベルを参照してください。 

Sample Rate（サンプリング周波数） 

 機器の現在のサンプリング周波数を表示します。Dante 機器のサンプリング周波数は変更可能です。

この変更を有効にするために機器の再起動が必要となる場合があります。機器が対応するサンプリ

ング周波数はすべてドロップダウンメニューに表示されます。 

 機器の現在のプルアップ／プルダウン設定を表示します。この設定は変更可能です。プルアップ／

プルダウン設定を使用すれば、機器のサンプリング周波数を調整して、フレームレートが変換され

たビデオとオーディオを同期させることができます。たとえば、24 fps から 25 fps へ変換されたビ

デオに Dante オーディオを同期させるには、関連オーディオ機器のサンプリングレートのプルアッ

プ／プルダウン値を+4.1667%に設定します。 
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注: 機器のサンプリング周波数のプルアップ／プルダウン値を変更すると、その機器が専用のクロッ

クドメインに入ります。Dante 機器は同じクロックドメイン上の機器とのみオーディオ送受信ができ

ます。詳細は Clock Status 画面を参照してください。 

Device Latency 
現在の機器レイテンシー設定を表示します。選択した機器の受信レイテンシーは変更可能です。値を

選択して OK をクリックすると、機器が受信しているすべてのフローにそのレイテンシーが適用され

ます。  

注: 内蔵ネットワークスイッチを搭載した機器では、150 µsec の設定はできません。 

警告： レイテンシーの値を変更すると、この新しいレイテンシー設定でフローが再設定されるときに

音声が途切れる場合があります。 

Reset Device（機器のリセット） 
Dante インターフェースを遠隔再起動したり、工場出荷時の設定にリセットも可能です（Factory 
Reset）。Dante 機器を再起動するには、リセットする機器を含むホストオーディオ機器のリセット

も必要な場合があります。 

Factory Reset ボタンを押すと、以下の機器設定がリセットされます。 

 ユーザー定義の機器名 

 ユーザー定義のチャンネルラベル 

 クロック設定（クロックマスター／外部クロックマスター設定） 

 静的 IP アドレス 

 リダンダンシー設定 

 サンプリング周波数設定（プルアップ／プルダウンを含む） 

 レイテンシー設定 

 既存のオーディオルーティング 

対応機器では工場出荷時の設定にリセットする代わりに Clear Configuration（クリア設定）が選択で

きます。Clear Configuration は上記と同じ設定をリセットしますが、IP 設定だけをリセットしないよ

う選択できます。その場合、Dante リダンダンシー設定と、Network Config 画面で現在設定されてい

るすべての静的 IP アドレスはそのまま保持されます。  

設定をクリアした後は、その変更を有効にするために機器の再起動が必要です。機器によっては設定

をクリア後自動的に再起動する場合もあります。この選択肢がない場合は手動で再起動してください。 
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Network Config タブ 

Network Config タブでは、対応機器の Redundant モードと Switched モード間の切り替えや、機器の

イーサネットポートの静的 IP アドレスの指定を行います。 

 

Dante リダンダンシー／スイッチ設定 

機器メーカーの設定によっては、その機器の Redundant モードと Switched モード間の切り替えや、

スイッチ設定の選択ができます 

Redundant（リダンダント） 
Redundant に設定すると、同一の Dante オーディオトラフィックが両方のイーサネットポートに送ら

れるので、セカンダリーポートを介したリダンダンシーネットワークの導入ができます。リダンダン

シーに対応していない機器もあります。 

Switched（スイッチ） 
Switched に設定すると、セカンダリーのイーサネットポートが標準のスイッチポートとして動作する

ので、その機器を通してデイジーチェーンが可能になります。 

Switch Configuration（スイッチ設定） 
特定の機器はイーサネットポートのカスタムスイッチ設定やリダンダンシー設定に対応しています。

これらの機器では、Network Config 画面の一番上の枠に Switch Configuration（スイッチ設定）とい

うタイトルがつきます。該当機器の対応スイッチング設定についての情報は、メーカーの技術文書を

参照してください。 
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Addresses（アドレス） 

デフォルトでは Dante 機器は自動で IP アドレスを取得し、ほとんどの場合、Addresses（アドレス）

設定を変更する必要はありません。しかし必要に応じて静的 IP アドレスを割り当てることもできま

す。 

以下の手順で静的 IP アドレスを設定します。  

1. 適切なイーサネットポートに対して、“Manually configure an IP Address”（手動で IP アドレスを設

定）を選択します。 

2. IP Address および Netmask を入力します。 

3. Apply をクリックします。  

DNS Server と Gateway はオプション設定です。指定しなければネットワークのデフォルト設定が使

用されます。 

Revert をクリックすると、前回の設定に戻ります。  

注: 静的 IP アドレスを割り当てた場合は機器の再起動が必要です。 

HA Remote タブ 

対応機器(Dante-MY16-AUD カード v3.3.9 以上)では Device View に HA Remote タブも含まれていま

す。HA Remote タブでは機器の HA Remote ブリッジモードの選択をします。 

 
HA Remote はヤマハ製品で使用される専有のシリアルコントロールプロトコルです。HA リモートの

ブリッジモードについての詳細は、ヤマハのウェブサイトから Dante-MY16-AUD ユーザーガイドの

最新版をダウンロードしてください。 
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マルチキャスト送信のフロー設定 

Device View でマルチキャスト設定ボタンをクリックして、Create Multicast Flow ダイアログを開き

ます。 

 
このダイアログボックスには機器の Tx チャンネルのリストが示されており、チャンネル名の横の

ボックスをチェックすることで、そのチャンネルを新しいマルチキャストフローに追加することがで

きます。必要なチャンネルをすべて選択した後、ダイアログボックス下部の Create ボタンをクリッ

クすると、マルチキャストフローが作成されます。新しいマルチキャストフローの作成をキャンセル

するには、Cancel をクリックします。 

１つのマルチキャストフローにつき、その機器のフローあたりの最大対応チャンネル数を含むことが

できます。これはダイアログボックスの上部に表示され、この例では 8 チャンネルです。最大対応

チャンネル数を超えるチャンネルを選択すると、複数のフローが作成されます。  

フローが作成されると、そのフローに含まれるチャンネルとともに Transmit 欄のフローリストに表示

されます。既存のフローに対しチャンネルの追加や削除はできません。ダイアログボックスを使用し

て追加チャンネルを選択するたびに、新しいマルチキャストフローが作成されます。 

Dante 受信機器は、新しくユニキャストフローを作成するよりも、要求するチャンネルを含むマルチ

キャストフローが存在すればデフォルトで接続します。もし既存のマルチキャストフローに含まれな

いチャンネルが新しいマルチキャストフローに追加されると、そのチャンネルへの既存のユニキャス

トのサブスクリプションは、自動的に新しいマルチキャストフローを使用するように切り替えられま

す。 

マルチキャストフローを削除するときには、既存のサブスクリプションがユニキャストに戻る可能性

があるため、ご注意ください。これにより送信機と受信機の間で複数のユニキャストフローが設定さ

れるために、送信機器側でリンク容量または最大フロー数を超える可能性があります。マルチキャス

トフローを削除する前に、オーディオルーティングの一部または全部を削除することをお勧めします。 

基本的には、特定のオーディオチャンネルに３つ以上の受信機がある場合はマルチキャストを使うこ

とをお勧めします。またネットワークの隅々までフローが過剰に流れ、ネットワークリンクすべての

帯域幅を消費するということにもご注意ください。 

注: イーサネットスイッチの中には、不要なマルチキャストトラフィックを制御し、そのトラフィッ

クを必要とする伝送先にのみ届くようにするプロトコルである IGMP（インターネット・グループ・

マネジメント・プロトコル）に対応しているものがあります。IGMP に対応しており、すべてのイー

サネットスイッチで IGMP が正しく設定されている場合には、マルチキャストオーディオはネット

ワークに過剰流出せず、サブスクリプション設定した機器に伝送するのに必要なリンクにのみ送られ

ます。 
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プリセット 
Dante Controller では、プリセットとしてネットワークルーティングのセーブ、ロード、およびデバ

イス設定ができます。プリセットファイルにはネットワークのすべてか複数の機器の設定とルーティ

ングパラメーターが含まれています。  

プリセットファイルは xml として保存し、オフラインで編集することもできます。さらに、それらは

“機器間で互換性がある”ので、別のネットワークの異なる物理デバイスと共有することもできます。 

プリセットを以下の目的で使用できます。  

 ネットワーク設定をバックアップ、復元する 

 保存されたネットワーク設定をすばやく切り替える 

 ネットワーク設定をテストネットワークからライブまたはスタジオネットワークにコピーする保存

されたネットワーク設定をすばやく切り替える 

 新しいネットワーク設定を特別な、あるいは定期的なイベント用に作成した後、必要に応じて元の

基本設定に切り換える 

 複数の設定を多くの機器に同時にすばやく適用する－たとえば、ネットワーク上のすべての機器を

同じサンプリング周波数(global configuration) に設定する 

 Dante Controller をオフラインの編集ツールとして使用する－保存したプリセット設定をオフライン

で編集し、新しく追加するネットワーク設定のために再利用する 

機器のロールについて 

プリセットによる“機器のロール（役割）”というコンセプトが導入されています。プリセットが保存

されると、選択された機器の設定とルーティングが機器のロールとしてプリセットの中に保存され、

それが作成された機器と同じ名前になります。  

ロールはオリジナルの機器に限定していません。プリセットが Dante Controller に読み込まれると、

それぞれのロールがオリジナルまたは他の機器に（正確に同じ機能性に対応していなくても）適用さ

れます。機器設定とルーティングパラメーターはセットで移動できます。 

例: 

サウンドエンジニアのデイブは金曜日と土曜日の夜、地方会場でライブの予定がある。ライブ前の金

曜日の夕方、デイブは地方会場でネットワークをセットアップし、それに満足したので、プリセット

に保存した。 
 
ライブのあと、デイブのボスが、他の仕事のためにこのミキシングコンソールを取り上げた。しかし、

デイブは同じような（うまい具合に同じメーカーで、より高いチャンネル数の）コンソールを持った

友達がいて、それを土曜日の演奏のために借りることができた。 
 
次の日、デイブは新しいミキシングコンソールをネットワークに接続して、プリセットを読み込ませ

た。新しいコンソールはすべての適切なチャンネルラベルとオーディオサブスクリプションを含めて、

古いコンソールとまったく同じ設定ができ、ネットワーク機能も正確に前のままで、特別な設定は必

要なかった。ライブは問題なく、首尾よく終了し、バンドはデイブを夕食にさそった。 
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ロールをオリジナルの機器とは違う機器に適用すると（たとえばコンソールモデルＡをコンソールモ

デルＢにした場合）、Dante Controller は起こりうる問題（対応していないサンプリング周波数など）

を見分け、それらの問題を表示し、知らせたりあるいは重要でないなら無視したりします。 

プリセットの保存 

 
すべての機器パラメーターを含むプリセットを保存するには 

1. メインツールバー  の“Save Preset”ボタンをクリックします。 

2. プリセットに含めたい機器を選択します。  

すべての機器を選択するには All を、すべての選択をクリアするには None をクリックします。 

3. Save をクリックします。 

機器パラメーターの選択を含むプリセットを保存するには 

1. メインツールバーの“Save Preset”ボタンをクリックします。  

2. Advanced をクリックします。 

3. プリセットに含めたい機器を選択します。 

4. 選択した機器に保存したいパラメーターを選択します。 

5. Save をクリックします。 

プリセットは xml ファイルとして保存し、必要ならテキストエディターを使って、それを手動で編集

することもできます。 
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パラメーターのルール 

RX サブスクリプション 
プリセットに RX サブスクリプションが含まれており、目的のシステムに適用している場合（たとえ

ば、プリセットが保存される際 Advanced > Parameters 欄でチェックされ、かつプリセットが適用さ

れる際 Preset Elements 欄でチェックされている場合）： 

目的のシステムで適合するすべての機器において、サブスクリプションはソースシステムにマッチす

るようにアップデートされます。その結果、以下のようになります。 

 プリセットに保存されているすべてのサブスクリプションは、それぞれのターゲットシステムの

マッチする機器で上書きされます。同一のサブスクリプションは保持されます。 
 プリセットの設定内容にかかわらず、プリセットに含まれないサブスクリプションがターゲットシ

ステムにある場合サブスクリプションは削除されます。 

TX フロー（マルチキャストフロー） 
TX フローと TX チャンネルラベルの設定時の動きは RX サブスクリプションと異なります。 

プリセットに「TX Flows」が含まれており、目的のシステムに適用している場合（たとえば、プリ

セットが保存される際、「TX Flows」が Advanced > Parameters 欄でチェックされ、かつプリセット

が適用される際 Preset Elements 欄でチェックされている場合）： 

 プリセットに保存されているすべての TX フローは、それぞれのターゲットシステムのマッチする機

器で上書きされます。 
 1 つでもプリセットの TX フローが設定された場合、プリセットに含まれない TX フローがターゲッ

トシステムにあれば TX フローは削除されます。逆にプリセットの TX フローが設定されなかった場

合はターゲットシステムのすべての TX フローは保持されます（RX サブスクリプションと扱いが違

いますので注意してください）。 
 プリセットを設定する前にマルチキャストフローおよび（または）送信チャンネル名は手動でター

ゲット機器から削除できます。 

TX チャンネルラベル 
TX チャンネルラベルの設定時の動きは上述の TX フローと同じです。 

プリセットの適用 

保存されたプリセットを読み込み、適用するには、メインメニュー(Ctrl + L)から File > Load Preset
を選択します。 

以前のバージョンのプリセットファイルも読み込めます。 

 “Apply Preset”ダイアログは 4 欄に分かれていて、プリセットを適用するときの論理的な手順を表し

ます（左から右に）。 
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プリセットの要素 

目的のネットワークに適用したいパラメーターをプリセットから選択するには、Preset Elements 欄

を使用します。 

 
目的のネットワークがオリジナルのネットワーク（プリセットが保存されたところ）と同一でない場

合、要素によっては正しく適用されないことがあります。たとえば、目的のネットワークの機器がオ
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リジナルのネットワークの機器と同じサンプリング周波数レンジに対応していない場合、 “デバイス

サンプリング周波数”要素を適用しない選択をし、プリセットが適用されてから、サンプリング周波数

を手動で変更することができます。 

プリセットのロール 

Preset Roles 欄はプリセットで保存されたロールを表示します。 

 
ロールは、それが作成されたところと同じ物理デバイスに（目的のネットワークに存在する場合）、

または同じネットワークの異なるデバイスに、または新しいネットワークの他のデバイスに適用でき

ます。  

ロールが同じ物理デバイス、またはまったく同じモデルのデバイスに適用するなら、設定とルーティ

ングは完全に再現できるはずです（しかし、適切な送信機が目的のネットワークに存在していないと、

サブスクリプションによっては外れる場合があります）。 

注: 比較的静的なネットワークの場合は、設定をバックアップし、プリセットを復元して使用するの

が理想的です。 

ロールが異なるデバイスモデル、または異なるタイプのデバイスに適用する場合、設定とルーティン

グは正確に再現されないこともあります‐ロールの割り当てが成功するかは目的のデバイスの機能性

とチャンネル対応によります。 

異なるタイプのデバイスにロールを適用すると、基本的にはあまり良い結果が得られません。たとえ

ば、96kHz に設定されて 32 チャンネルすべてサブスクリプションされたミキシングコンソールの

ロールを、48kHz のみ対応の 2 チャンネルアンプに適用するのは、問題です（送信機も存在する場合、

2 チャンネルのみサブスクリプションされ、サンプリング周波数が拒否されることがあります）。 

ロールを複数のデバイスに適用できます。複数のロールをひとつのデバイスに適用することはできま

せん。  

どのデバイスにロールが割り当てられたかを見るにはロールをクリックします。割り当てられたデバ

イスは“Target Devices”欄に表示されます。 
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自動割り当て 
Dante Controller は以下の規則で自動的にロールをデバイスに割り当てます。 

 完全にマッチするデバイスがある場合は（ロールが作成されたオリジナルのネットワークの物理デ

バイスが目的のネットワークにもある場合など）、ロールは自動的に割り当てられます。 
 マッチするデバイス名がある場合は、ロールは自動的に割り当てられます。 

 完全マッチまたはデバイス名マッチがない場合は、このタイプで割り当てられていないデバイスが

あると仮定し、ロールは同じメーカー、同じモデルのデバイスに自動的に割り当てられます。 

割り当てを削除する 

割り当てを削除するには、目的のデバイスを選択して Clear をクリックするか、またはキーボードの

Delete キーを押します。 

手動割り当て 
ロールをデバイスに手動で適用するには  

 ロールをデバイスにドラッグする、または  

 “Preset Roles”欄のロールと“Target Devices”欄の目的のデバイスを選択し、Apply をクリックします。 

各ロールに対する LED アイコンはロールの割り当て状態を示します。 

 グレーのアイコンは、ロールがどの目的デバイスにも割り当てられていないことを示します。 

 緑色のアイコンは、ロールが正しくひとつまたは複数の目的デバイスに割り当てられたことを示

します。 

 オレンジ色のアイコンは、ロールがひとつまたは複数のデバイスに割り当てられたが、ひとつま

たは複数の割り当てに関連する警告があることを示します。 

 赤色のアイコンは、ロールがひとつまたは複数の目的デバイスに割り当てられたが、ひとつまた

は複数の割り当てに関連するエラーがあることを示します。 

 黒色のアイコンは、ロールが目的のデバイスに割り当てられたが、割り当てがネットワーク上で

端末の動作に影響があることを示します。端末に問題が発生した場合はプリセットを適用できません。 

目的のデバイス 

Target Devices 欄にはネットワークに現在接続しているデバイスの名前と、それらに割り当てられて

いるロール（もしあれば）が表示されます。 
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各デバイスに対する LED アイコンはデバイスの割り当て状態を示します。 

 グレーのアイコンは、ロールがデバイスに割り当てられていないことを示します。 

 緑色のアイコンは、ロールがデバイスに正しく割り当てられていることを示します。 

 オレンジ色のアイコンは、ロールがデバイスに割り当てられたが、割り当てに関連する警告があ

ることを示します。 

 赤色のアイコンは、ロールがデバイスに割り当てられたが、割り当てに関連するエラーがあるこ

とを示します。 

 黒色のアイコンは、ロールがデバイスに割り当てられたが、割り当てがネットワーク上で端末の

動作に影響があることを示します。端末に問題が発生したらプリセットは適用できません。 

問題 

Issues 欄は Dante Controller で発生したすべての問題を示します。ロールまたは目的のデバイスをク

リックしてロールまたはロールの割り当てに関連する問題を示します。 
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以下はネットワークが使えなくなる重大な問題です（黒色 LED アイコンで示されます）。 

 同じデバイス名を複数のデバイスに適用できません。 

 同じ静的 IP アドレスを複数のデバイスに適用できません。 

お使いのネットワークによっては、他にも問題となる場合があります。 

プリセットの適用 

プリセットを適用するには、OK をクリックします。操作を中断するには Cancel をクリックします。 

Global Configuration（全体設定） 

全体設定のため特化したプリセットを使用できます。たとえば、ひとつまたは複数の設定を多くのデ

バイスに同時に適用したいときに使用します。 

例： ネットワークのすべてのデバイスに同じサンプリング周波数を適用するには 

1. ひとつのデバイスに必要なサンプリング周波数を設定します。 

2. Save Preset ボタンをクリックします。  

3. None をクリックして、次に適切なデバイスだけを選択します。 

4. Advanced をクリックします。 

5. None をクリックして、次に“デバイスサンプリング周波数”チェックボックスを選択します。 

6. Save をクリックします。 

7. プリセットを読み込みます(File > Load Preset)。 

8. “Preset Roles”欄で適切なロールを選択します。 

9. “Target Devices”欄で Select All をクリックします。 

10. Apply をクリックし、次に OK をクリックします。 

これですべてのデバイスを同じサンプリング周波数に設定しますが、他のすべてのデバイス設定はそ

のままです。 
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トラブルシューティング 

ファンアウト 

Transmit Flows（送信フロー）について 

送信フローとは、機器間でデータを供給するオーディオパケットの「ストリーム」のことです。

Dante 機器は特定のハードウェア構成とファームウェアバージョンに応じて、送信フローの数をサ

ポートすることができます。 

Dante 機器はユニキャストとマルチキャストの 2 種類のフローをサポートしています。 

ユニキャストフローは、特定の機器にオーディオを供給するために使用され、同時に 4 チャンネルの

オーディオをサポートします。1 台の送信機の 4 チャンネルを受信機にサブスクライブするのであれ

ば、そのオーディオデータは、1 つのフローを用いて供給されることになります。もしその後、5 番

目のチャンネルをサブスクライブする場合、2 つ目のフローを作成しなければなりません。 

4 台の受信機を 1 台の送信機の同一チャンネルにサブスクライブしたい場合、オーディオは 4 箇所の

異なる機器に送信されるため Dante Controller は 4 つのユニキャストフローを作成する必要がありま

す。この場合は 1 つのマルチキャストフローを作成する方が良いでしょう。 

マルチキャストフローはオーディオをネットワーク上に「一斉送信」しますので、複数の受信機が

オーディオにサブスクライブできますが、送信機は 1 つのフローを用いて供給するのみです。マルチ

キャストフローは、最大 8 チャンネルを設定することができます。しかし、マルチキャストのオー

ディオトラフィックは、ネットワーク内のすべてのリンク上で帯域幅を使用して、オーディオを必要

としていないリンクも含め、ネットワーク全体に送信してしまいます。特に 100Mbps リンクの場合

にはマルチキャストフローが多数存在するとすぐに飽和状態になります。そのため、マルチキャスト

フローの使用は本当に必要な場合のみにしてください。 

ユニキャストフローを介して 1 つのチャネルに多数の機器をサブスクライブしている場合、Dante 
Controller は、「Fanout Configuration detected（ファンアウトの設定が検出されました）」のメッ

セージを表示して注意を促します。 

その後、サポートされている送信フローの数を超えると、それ以上のサブスクリプションは失敗し、

失敗したサブスクリプションのツールチップは、「No more flows（フローなし）: 送信機はこれ以上

のフローをサポートできません」と表示します。このような場合は受信機のサブスクリプションを解

除する、またはマルチキャストフローに切り替えることでファンアウトを減らす必要があります。 
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起動時のエラーメッセージ 

 

エラーメッセージ 症状と対策 

'Dante Controller was unable to connect to the 
Dante Control and Monitoring manager. Dante 
Controller cannot function without this 
connection. This problem is most likely caused 
by the Dante Control and Monitoring ('conmon') 
service or daemon stopping unexpectedly. Click 
OK to restart Dante Controller. You may also 
need to manually restart the Dante Control and 
Monitoring service, or the computer, if the 
problem reoccurs.' 

対象: OS:Windows のみ 
症状: Dante コントロールとモニターサービスが応答して

いません。コンピュータがスリープモードになったときに

この問題が発生する場合があります。 
対策: Dante Controller を再起動します。それでも解決し

ない場合は、パソコンを再起動するか、コントロールパネ

ル＞管理ツール＞サービス を選択し、Dante コントロール

とモニターサービスを再起動してください。  

'The installed version [x] of the Dante Control 
and Monitoring service (‘ConMon’) is out of 
date.  
This version of Dante Controller requires 
ConMon version [x] or later.  
Please reinstall Dante Controller to resolve this 
issue. Dante Controller will now exit.'  

対象: OS:Windows および Mac OS X 
症状: 他の Dante ソフトウェアにより Dante Controller が
インストールされ、ConMon サービスが古いバージョンで

書き換えられた可能性があります。 
対策: Dante Controller を再インストールします。これに

より ConMon サービスを最新バージョンにアップデートで

きます。 

'The installed version [x] of the Dante Discovery 
service is out of date.  
This version of Dante Controller requires Dante 
Discovery version [x] or later.  
Please reinstall Dante Controller to resolve this 
issue. 
Dante Controller will now exit.' 

対象: OS:Windows のみ 
症状: 他の Dante ソフトウェアにより Dante Controller が
インストールされ、Dante Discovery サービスが古いバー

ジョンで書き換えられた可能性があります。 
対策: Dante Controller を再インストールします。これに

より Dante Discovery サービスを最新バージョンにアップ

デートできます。 

 

パソコンの設定確認リスト 

Dante Controller をインストールする前に、必ずアドミニストレーターとしてパソコンにログインし

てください。 

Dante ネットワークで使用するためにパソコンを正しく設定するには、以下の内容を確認してくださ

い。 

 Dante Controller がインストールされていること 

 正しいネットワークインターフェースが選択されていること 

 正しい IP アドレスが使用されていること 
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サードパーティーのファイアウォール設定 

 Windows と Mac の標準のファイアウォールは通常インストール時に設定されます。 

 サードパーティー製のファイアウォールは手動で設定する必要があります。 

お使いのパソコンにサードパーティー製のファイアウォールがインストールされている場合は、ファ

イアウォールの要件と設定の詳細について、Dante Controller と Dante Virtual Soundcard のユーザー

ガイドを参照してください。 

Dante IP アドレス設定 

Dante ネットワーク上の機器は、Dante Virtual Soundcard も含めすべて同一ネットワークからの IP
アドレスを使用します。Dante Virtual Soundcard や Dante Controller を使用する際はパソコンをプラ

イマリーと/またはセカンダリーネットワークに接続して正しい IP アドレスを設定してください。 

注:機器名が赤で表示されている場合、Dante Controller が IP アドレス設定問題など、エラー状態を自

動検出したことになります。またはデバイスがフェイルセーフに入っています。赤で表示されている

機器名をダブルクリックして詳細を確認してください。 

IP 設定の修正 

Dante ハードウェア機器は以下のいずれかの方法でネットワークから IP アドレスを自動取得します。 

 169.254.*.*の範囲のアドレス（セカンダリーネットワークが存在する場合、セカンダリーネット

ワークは 172.31.*.*の範囲のアドレス）を自動割り当てします。 

 DHCP サーバーがネットワークに存在する場合には、DHCP サーバーから IP アドレスを得ます。 

お使いの PC または Mac コンピュータの TCP/IP ネットワーク設定を、“Obtain an IP address 
automatically”（IP アドレスを自動取得）に設定してください。他の Dante 機器と同じネットワーク

でリンクローカルの自動 IP アドレスを自動的に取得します。DHCP サーバーが存在するときには、

コンピュータおよび Dante 機器は DHCP サーバー経由で IP アドレスを取得します。 

IP ネットワーク設定でありがちなミス 

以下のようなネットワーク設定エラーが生じることがあります。Dante Controller はこれを自動検出

します。検出されたエラーのある機器は赤で表示されます。 

PC/Mac の IP 設定ミス 

 同一サブネットのアドレスを持つ複数のネットワークインターフェースが存在する 

 セカンダリーネットワークがリンクローカル（DHCP サーバーを持たない）を使用している場合、

ネットワークのすべてのデバイスのレンジは 172.31.*.*です。コンピュータのセカンダリーネット

ワークインターフェースは（静的 IP アドレスを使用して）手動で同じレンジに設定されなくてはな

りません。 
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IP の一般設定ミス 

 同一ネットワーク上に複数の DHCP サーバーが存在する 

異常 – たとえば DHCP サーバーが作動していることを気がつかずにネットワークにパソコン

を接続している場合があります。 

 静的 IP アドレスの設定ミス 

静的 IP アドレスを設定する必要性はまったくありません。特別な理由があって設定する場合

は、ネットワークの他の機器と同じサブネットにあることが必要です。 

リダンダンシーネットワーク設定ミス 
リダンダンシーネットワークの設定については“ルーティングオーディオ”を参照してください。リダ

ンダンシーネットワークの設定ミスは何種類かあります。そのうちの複数のミスが同時に存在するこ

ともあります。 

 Dante 機器のセカンダリーインターフェースがプライマリーネットワークに接続されている 

最もよくあるミスは、リダンダンシーの仕組みを誤解して、すべてのケーブルを 1 つのス

イッチのみに接続していること、あるいは、2 つのスイッチまたはネットワークを正しく使用

しているにもかかわらず、1 本のセカンダリーケーブルをプライマリーネットワークのスイッ

チに接続していることが考えられます。 

 プライマリーネットワークとセカンダリーネットワークを一緒に接続している 

プライマリースイッチとセカンダリースイッチを接続しているか、1 つのスイッチだけを使用

してしまっています。 

 同一機器上にある複数のインターフェースが、同じ IP アドレスサブネットを使用している 

プライマリーネットワークとセカンダリーネットワークの両方で同一の DHCP サーバーを使

用しているか、両 DHCP サーバーが同一の IP アドレスに対応するよう設定されている可能性

があります。また、DHCP とリンクローカルが同じネットワークで混在すると問題を起こす

ことがあります。すべてのデバイスとコンピュータを DHCP かリンクローカルのどちらかに

することが必要となることがあります。 

パソコンで不適切なインターフェースを使用した時の症状 

有線ネットワークのインターフェースが複数あり、他の Dante 機器の接続先であるインターフェース

を Dante Controller が使用していない場合は、以下の症状が見られます。 

 Dante Controller が機器を認識できない。 

 Dante Virtual Soundcard がオーディオの送受信を行わない。 

Dante Controller の使用しているネットワークインターフェースの確認 

 選択したインターフェースは Dante Controller の Network View のツールバーにある“インターフェー

ス選択”ボタン で表示、変更ができます。 
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 Dante ネットワークがスタンドアローンであり DHCP サーバーを持たない場合には、このアドレス

は 169.254.*.*です。 

 Dante ネットワークが DHCP サーバーを持つ場合には、（上図に示すように）IP アドレスは使用し

ているアドレス方式に一致するはずです。 

ネットワーク上の Dante 機器の IP アドレスの確認 

 ネットワーク上の Dante 機器に設定されている IP アドレスは、Device Info タブで確認できます。 

 

 全機器のプライマリーアドレスが同じ IP アドレス表記に従っていることが必要です（例：

169.254.*.*または 10.12.0.*）。セカンダリーアドレスについても同様です。 

 古い Dante 機器や以前のファームウェアを使用している機器によっては、この情報を表示しない場

合があります。 

スイッチ設定および ケーブル 

ケーブルはネットワーク系統で最も跪弱な部分です。ケーブルに関する問題点が疑われるときは、以

下の確認を行ってください。 

 ケーブルが不良、または手動で終端されている。 

 イーサネットケーブルが外れている、または接続不良。 

 スイッチの設定ミス。 

 Dante 機器が取り外されている、または電源オフになっている。 

スイッチ／ケーブルに問題がある場合の症状 

 Dante Controller の Network View で機器が表示されない。 

 Dante Controller にオレンジの「サブスクリプション失敗」アイコンが表示される。これは通常、以

前あった機器が今は存在していないことを示しています。 

 ケーブル不具合による音飛びまたはノイズが発生する。 

 Dante Controller に Dante 機器が表示されたり消えたりする。 
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スイッチ／ケーブルの点検項目 

 スイッチの接続リンク／ステータスのインジケータがすべて想定どおり点灯または点滅しています

か？ 

o スイッチの電源は入っていますか？ 

o ケーブルが正しくスイッチおよび PC または機器に接続されていますか？ 

 スイッチが正しく設定されていますか？ 

o VLAN または QoS が正しく設定されていない可能性があります。 

 別のアプリケーションのスイッチを点検確認しないまま使用していませんか？ 

o スイッチの取扱説明書を参照してスイッチ設定を確認してください。 
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